Лабораторный практикум 
 по дисциплине «Алгоритмические основы машинной графики»
Лабораторный практикум включает четыре лабораторных работ.
При выполнении всех лабораторных работ каждый студент получает свое индивидуальное задание, номер которого определяется преподавателем или самим студентом. В последнем случае номер индивидуального задания определяется как остаток от деления последних двух цифр номера зачетной книжки на количество имеющихся лабораторной работе вариантов, приводимых в таблице индивидуальных заданий описания лабораторной работы.
В приложении дается краткое описание графического редактора Corel  Draw, которое используется при выполнении практических работ №2 и №3.
Лабораторная работа №1
«Анимация и морфинг»

В общем случае, при выполнении данной работы необходимо разработать программу, обеспечивающую создание на экране семейства фигур заданной формы.

Программа должна предусматривать два режима отображения графической информации:

· отображение на экране всего множества заданных фигур;

· отображение одной текущей фигуры.

Переход от первого режима ко второму может быть осуществлен за счет того, что каждая фигура прорисовывается на экране дважды:

· первый раз фигура прорисовывается заданным цветом;

· второй раз та же фигура прорисовывается с использованием цвета фона.

 Для нормального восприятия фигуры следующая прорисовка объекта в обоих режимах должна выполняться с задержкой. Выбор величины задержки осуществляется студентом.

Фигуры-многоугольники отображаются по узловым точкам с использованием функции отображения отрезка прямой линии по его двум конечным точкам. 
Узловые точки исходной фигуры выбираются студентом произвольно с учетом отображения заданной формы и нормального восприятия многоугольника на экране. Для получения узловых точек каждой очередной фигуры необходимо рассчитать очередной набор узловых точек в соответствии с заданной анимацией и морфингом фигуры.

При создании эффекта анимации используются два основных способа перемещения формируемых фигур.

1-ый способ перемещения. 
При этом способе необходимо обеспечить метаморфозу многоугольника из начальной формы в  заданную конечную форму. На приведенном рисунке (рис.1-1)  этот способ иллюстрируется для случая перехода исходного квадрата в конечный треугольник.
В общем случае при этом способе необходимо выполнить следующие действия.

1. Одним из способов устанавливается связь между опорными точками исходной фигуры и ее конечной формы.
2. Для каждой исходной опорной точки определяется шаг движения исходной опорной точки к конечной по соответствующей линии-траектории, соединяющей рассматриваемые точки. Этот шаг рассчитывается посредством деления длины линии-траектории на число заданных шагов (это число во всех вариантах равно 30). Линия-траектория на экране не отображается. 

3. Формируются новые координаты опорной точки, используя полученный для этой точки шаг перемещения.

4. Строится новый многоугольник с использованием полученного набора узловых точек.
Связь начальных и конечных узловых точек может задаваться:

· в соответствии с  последовательности их расположения в контуре фигуры; в свою очередь в этом случае возможны два варианта:

· узловые точки начальной и конечной фигур берутся в одинаковом направлении, т.е. в направлении по ходу часовой стрелки (схема 1)  или в направлении  против часовой стрелки (схема 2);

· узловые точки начальной и конечной фигур берутся с использованием разного направления их обхода в контуре фигуры, например, в исходной фигуре они берутся в порядке направления  хода часовой, а в конечной – в направлении против часовой стрелки (схема 3), или наоборот (схема 4);

· связь конечных и начальных узловых точек  выбираться случайным образом (используется функция  «random» (схема 5).

Рис.1-1
На приведенном рисунке (Рис.1-1) используется связь начальных точек с конечными по схеме 2.
При рассматриваемом способе метаморфозы возможно использование вертикальной перегородки. Перегородка располагается между исходной и конечной фигурами (примерно посередине) и на экране не отображается. Она используется только для расчета очередного набора узловых точек. За первую половину заданного количества шагов (15 шагов) узловая точка перемещается от своего начального положения до точки пересечения соответствующей ей линии-траектории с линией-перегородкой. За вторую половину заданного количества шагов узловая точка перемещается от своего положения на линии-перегородки  до конечной узловой точки. 
При этом возможны следующие варианты соединения текущих узловых точек:

· порядок соединение узловых точек в каждом наборе сохраняется на всей траектории перемещения (от начального узловой точки до линии- перегородки и далее до конечного положения) и определяется по одной из выше описанные схемы 1-5 (вариант «П1»;
· порядок соединение узловых точек в каждом наборе до линии-перегородки соответствует порядку расположения соответствующих узловых точек в исходном многоугольнике, а после перегородки соединение узловых точек в каждом очередном наборе соответствует порядку расположения соответствующих узловых точек в конечном многоугольнике (вариант «П2»).

Если количество опорных точек в исходной и конечной фигуре не совпадают, то в набор с меньшим количеством опорных точек вводится дополнительные точки. Например, на рис.1-1 представлен случай, при котором в набор узловых точек конечной фигуры пришлось ввести дополнительную точку, удвоив количество точек в вершине А конечного треугольника. Дополнительно вводимые точки не обязательно должны располагаются в вершинах многоугольника. Их можно брать и на ребрах (например, на середине ребра). Выбор местоположения дополнительно вводимых точек осуществляется студентом. 
2-ый способ перемещения.
 При этом способе необходимо обеспечить хаотическое движение изменяющегося многоугольника.
Хаотическое движение многоугольника может быть получено  за счет изменения положения его центра на вектор направления V с параметрами (vx,vy), где: 
· vx – проекция вектора V на координатную ось X, которая рассчитывается согласно выражению:

                vx =rx;
· vy – проекция вектора V на координатную ось Y, которая рассчитывается согласно выражению:
                 vy =sy;
· r и s – коэффициенты, задаваемые функцией random; они могут принимать значения в диапазоне от -2 до +2.

Значение для  x и  y задаются студентом, но при условии обеспечения эффекта движения без скачков.
Изменение фигуры может происходить посредством:
· уменьшением  масштаба (рис.1-2 b) на каждом  шаге на величину 1/30 ее текущего размера (динамический режим ДР1);

· перемещением узловой точки к ближайшей соседней узловой точке (рис.1-2 a) по ребру на 1/30 часть текущей длины ребра (динамический режим ДР2).

Рис.
Перечень вариантов  приведен в виде таблицы

Рис.1-2
Перечень индивидуальных заданий  по данной лабораторной работе приведен в таблице 1-1
Варианты индивидуальных заданий. Таблица 1-1
	№ варианта


	Многоугольник  1 


	Многоугольник 2
	Способ перемещения
	Способ изменения
	перегородка
	Схема связи
	

	1 
	3
	4
	1
	-
	-
	1
	

	2 
	4
	5
	1
	-
	-
	2
	

	3 
	5
	6
	1
	-
	-
	3
	

	4 
	6
	3
	1
	-
	-
	4
	

	5 
	3
	5*
	1
	-
	-
	5
	

	6 
	4
	6
	1
	-
	Пр1
	1
	

	7 
	5
	3
	1
	-
	Пр1
	2
	

	8 
	6
	4
	1
	-
	Пр1
	3
	

	9 
	3
	6*
	1
	-
	Пр2
	4
	

	10 
	4
	3
	1
	-
	Пр2
	5
	

	11 
	5
	4
	1
	-
	Пр2
	1
	

	12 
	6
	-
	2
	1
	-
	ДР1
	

	13 
	3
	-
	2
	1
	-
	ДР1
	

	14 
	4
	-
	2
	1
	-
	ДР1
	

	15 
	5*
	-
	2
	2
	-
	ДР2
	

	16 
	6
	-
	2
	2
	-
	ДР2
	

	17 
	
	
	
	
	
	
	


Примечание: запись n* означает, что фигура имеет форму n-конечной звезды (в этом случае ребра фигуры формируются за счет соединения узловых точек через одну). 
Лабораторная работа № 2
«Отсечение прямоугольным окном».

При выполнении данной работы необходимо написать программу, выполняющую заданное (внутреннее или внешнее) отсечения окном. Форма окна  определяется индивидуальным заданием. Программы должны быть основаны на алгоритме отсечения прямоугольным окном Сазерленда-Коуэна. Описание этого алгоритма приведено в тексте лекций по данной дисциплине. Работу составленной программы необходимо  продемонстрировать на примере отсечения перемещающейся фигуры, полученной в результате выполнения лабораторной работы № 1, окном заданной формы.
Реализация отсечения многоугольниками заданных форм требует в некоторых случаях выполнения нескольких отсечений (внутренних и внешних) для отдельных окон, на которые нужно разбить заданную форму многоугольника. Например, внутреннее отсечение окном, имеющим форму «а», приведенную на рис.4-1, можно выполнить, реализовав внутреннее отсечение для окна в форме горизонтального прямоугольника, и внутреннее отсечение для окна в форме вертикального прямоугольника. Сумму видимых частей, полученных для этих двух отсечений, и будет результатом отсечения окном заданной формы.

Рис.4-1
Перечень индивидуальных заданий приведен в таблице 4-1.
Индивидуальные задания.    Таблица 4-1
	№ 

варианта
	Вид отсечения
	Вид окна

	1 
	внешнее
	1

	2 
	Внешнее
	2

	3 
	Внешнее
	3

	4 
	Внешнее
	4

	5 
	Внешнее
	5

	6 
	внешнее
	6

	7 
	внутреннее
	1

	8 
	Внутреннее
	2

	9 
	Внутреннее
	3

	10 
	Внутреннее
	4

	11 
	Внутреннее
	5

	12 
	внутреннее
	6

	13 
	
	


Примечание. В графе «Вид окна» используются обозначения форм окна, принятые  рис.4-1. Конкретные размеры заданного окна выбираются студентом с учетом сохранения заданной формы.
Лабораторная работа № 3
«Отсечение многоугольным окном».

 При выполнении данной работы необходимо написать программу, выполняющую заданное (внутреннее или внешнее) отсечения окном заданной формы. Форма окна  определяется индивидуальным заданием. Программы должны быть основаны на алгоритме отсечения прямоугольным окном Кируса-Бэка. Описание этого алгоритма приведено в тексте лекций по данной дисциплине.

Работу составленной программы необходимо  продемонстрировать на примере отсечения перемещающейся фигуры, полученной в результате выполнения лабораторной работы № 1.

Перечень индивидуальных заданий приведен в таблице 5-1.
Индивидуальные задания.   Таблица 5-1
	№

варианта
	Вид 

отсечения
	Форма 

окна

	1 
	внутреннее
	a

	2 
	внутреннее
	b

	3 
	внутреннее
	c

	4 
	внутреннее
	d

	5 
	внутреннее
	e

	6 
	внутреннее
	f

	7 
	внутреннее
	g

	8 
	внешнее
	a

	9 
	внешнее
	b

	10 
	внешнее
	c

	11 
	внешнее
	d

	12 
	внешнее
	e

	13 
	внешнее
	f

	14 
	внешнее
	g


Примечание. Графа «Вид окна» определяет формы окна, приведенные на рис.5-1. Конкретные размеры заданного окна выбираются студентом с учетом сохранения заданной формы.



Рис.5-2

В приведенных формах окном является площадь, ограниченная внешним и внутренним контуром. Например, заданное окно формы «g» представляется закрашенной площадью на рис.5-3.


Рис.5-3

Лабораторная работа № 4
«Построение проекции трехмерного объекта»

При выполнении данной лабораторной работы необходимо построить заданную проекцию заданной фигуры.
В процессе выполнения работы необходимо:

· задать матрицу преобразования;

· построить проволочную модель объекта;

· удалить невидимые ребра;
· обеспечить заданную динамику отображения объекта.

Перспективная проекция иллюстрируется ниже приведенным рисунком (Рис.6-1).


Рис.6-1

На рисунке приняты следующие обозначения:

V –вектор определяющий направление проекции от точки наблюдения E до начала мировой системы координат;
· X, Y, Z – координатные оси исходной (мировой) системы координат;
·  модуль вектора V;
·  -угол между координатной осью X и проекцией вектора V на координатную плоскость XY мировой системы координат;
·  -угол между вектором V и осью Z мировой системы координат;
· Vx – проекция вектора V на ось X; 
· Vy – проекция вектора V на ось Y; 
· Vz – проекция вектора V на ось Z.
Формирование координат точки в видовой системе координат при перспективной проекции выполняется следующим образом: 
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где:
· координаты точки в мировой системе координат;
· координаты точки в видовой системе координат; 

·       
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· cosa; sin b; cosс; sin d;

· ux = -bc; uy = -bd; uz =-a.
Переход от координат точки в видовой системе координат к ее координатам на плоскости проекции (на экране) выполняется следующим образом: 
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Аксонометрическая проекция приведена на рис.6-2

Рис.6-2
На рисунке приведены следующие обозначения:

· ПП – плоскость проецирования;

· V – вектор направленности линий проецирования;

· a –  угол между осью Z и проекции вектора V  на координатную плоскость XZ;

· b – угол наклона вектора V к координатной плоскости XZ.
Переход к координатам точки на плоскости проекции выполняется в этом случае следующим образом:
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где:
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Связь между углами в аксонометрической проекции типа «диметрии» имеет вид:
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Значение углов в аксонометрической проекции типа «изометрии»:
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Переход к координатам на плоскости проекции при косоугольной проекции выполняется следующим образом:

Рx = сos 450;

Рy = sin 450.

Матрица, отражающая эту связь координат, имеет вид:
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Перечень индивидуальных заданий приведен в таблице.

Индивидуальные задания.                                                  Тблица 6-1
	№

вар.
	ди-

на-мика
	Вид проекции
	осн.

 при-
змы
	параметры проекции

	
	
	
	
	
	a,Uy)
	b,Ux)
	d


	1 
	d
	перспек.
	3
	5L
	200
	200
	2L

	2 
	a
	тримет.
	4
	
	450
	450 
	

	3 
	a
	диметрия
	5
	
	700
	-
	

	4 
	Xв
	изомет.
	6
	
	
	
	

	5 
	Xв
	косоуг.
	3
	
	cos 450
	sin 450
	

	6 
	
	перспек.
	4
	15L
	400
	400
	10L

	7 
	a
	тримет.
	5
	
	600
	300
	

	8 
	b
	диметрия
	6
	
	450
	-
	

	9 
	Yв
	изомет.
	3
	
	
	
	

	10 
	Yв
	косоуг.
	4
	
	cos 450
	sin 450
	

	11 
	
	перспек.
	5
	4L
	450
	450
	3L

	12 
	b
	тримет.
	6
	
	300
	600
	

	13 
	Xв
	диметрия
	3
	
	-
	300
	

	14 
	Zв
	изомет.
	4
	
	
	
	

	15 
	Xв
	косоуг.
	5
	
	cоs 300  
	sin 600
	

	16 
	
	персп.
	6
	7L
	450
	450
	7L


Примечание.
1. В качестве объекта  для проецирования используется прямоугольная призма, в качестве основания которой используется многоугольник, количество вершин которого задается в варианте. 

2. Конкретные параметры призмы выбираются студентом при сохранении заданной в варианте формы трех мерного объекта.

3. «L» соответствует длине максимального ребра призмы.
4. Графа «Динамика» задает:
· параметр проекции (, , , d для перспективной; a, b для аксонометрической; Ux, Uy для косоугольной проекций);

· Xв, Yв, Zв – оси видовой системы координат, относительно которых необходимо вращать построенный согласно заданию объект.
Практика 
Практические работы предполагают изучение трех, приведенных ниже. Выбор варианта выполняется аналогично тому, как это делается в лабораторном практикуме.
Тема №1«Использование графики редактора «Word» при составлении отчетов»

Данная лабораторная работа предусматривает составление отчета на тему «Минимизация логических функций  с использованием карт Карно» при использовании  средств, в том числе и графических, стандартного текстового  редактора.

Номер варианта индивидуального задания на минимизацию определяется как остаток от деления числа, представленного двумя последними цифрами номера зачетной книжки студента, выполняющего данную контрольную работу, на шестнадцать (число индивидуальных заданий, приведенных в соответствующей таблице). 

Задание включает:

· вид логической функции, подлежащей минимизации;

· логический базис, который необходимо использовать при построении минимизированного логического выражения.

Минимизируется функция пяти переменных.

Логическая функция задается в кодированной форме в виде перечня десятичных чисел, например:

1, 6, 7, 12, 13, 24, 25.

От кодированной формы представления функции необходимо перейти к нормальной записи логического выражения заданной для минимизации логической функции. При переходе нужно учитывать, что числа в задании варианта представляют кодированную запись конъюнкций переменных, представляющих собой  конституенты единицы в логической сумме, соответствующей запись заданной функции в совершенной дизъюнктивной нормальной форме. Для того чтобы получить конъюнкцию на основании заданного числа, необходимо найти двоичный пяти битовый эквивалент этого числа. При переходе от двоичной кодированной формы к соответствующей  конъюнкции необходимо учитывать то, что:

1, 2, 3, 4, 5 разряды двоичного кода (нумерация, начиная с левого разряда)  соответствуют логическим переменным x1, x2, x3, x4, x5 в конъюнкции, соответствующей конституенте единицы функции, заданной для минимизации. Соответствующая переменная xi, берется в виде:

· xi, если i-ый разряд двоичного числа имеет значение «1»;

· 
[image: image13.wmf]i

x

, если i-ый разряд двоичного числа имеет значение «0».

Для приведенного выше примера переход к нормальной записи логической  функции осуществляется следующим образом.

1, 6, 7, 12, 13, 24, 25 00001,00110, 00111, 01100, 01101, 11000, 11001

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В различных вариантах индивидуальных заданий используется три логических базиса:

· И, ИЛИ, НЕ;

· И-НЕ;

· ИЛИ-НЕ.

При выполнении задания необходимо сделать следующее.

1. Представить заданную для минимизации логическую функцию в СДНФ.

2. Построить карту Карно для пяти переменных.

3. Записать в карту Карно заданную функцию.

4. Ввести в карту контуры.

5. Записать минимизированное выражение для заданной функции.

6. Преобразовать минимальное выражение к форме соответствующей заданному логическому базису.

7. Синтезировать логическую схему, соответствующую полученному минимальному выражению для заданной функции, с использованием  заданного базиса.

Графика отчета должна быть максимально приближенной к хорошей ручной графической форме. Она должна быть жестко сгруппированной.

При записи логических выражений необходимо использовать функцию «Equation». 

Нельзя строить карту Карно на базе текстовой таблицы. 

Перечень вариантов приведен в виде таблице.

Индивидуальные задания                                                    Таблица 1-1

	№

варианта
	Логическая

функция
	Логический базис

	1. 
	1,2,3,9,17,10,28,27,30,31 
	И, ИЛИ, НЕ

	2. 
	2,3,4,5,6,14,15,22,24,17,29,30
	И-НЕ

	3. 
	3,4,5,6,7,10,8,22,23,27,28
	ИЛИ-НЕ

	4. 
	4,5,7,8,13,21,18,19,20,21,28
	И, ИЛИ, НЕ

	5. 
	1,2,3,9,17,10,28,27,30,31 
	И-НЕ

	6. 
	2,3,4,5,6,14,15,22,24,17,29,30
	ИЛИ-НЕ

	7. 
	3,4,5,6,7,10,8,22,23,27,28
	И, ИЛИ, НЕ

	8. 
	4,5,7,8,13,21,18,19,20,21,28
	И-НЕ

	9. 
	1,2,3,9,17,10,29,27,30,31 
	ИЛИ-НЕ

	10. 
	2,3,4,5,6,14,15,22,24,17,29,30
	И, ИЛИ, НЕ

	11. 
	3,4,5,6,7,10,8,22,21,27,28
	И-НЕ

	12. 
	4,5,7,8,13,21,18,19,20,21,28
	ИЛИ-НЕ

	13. 
	1,2,3,9,17,10,28,27,26,30,31 
	И, ИЛИ, НЕ

	14. 
	2,3,4,5,6,14,15,22,24,17,29,30
	И-НЕ

	15. 
	3,4,5,6,7,10,8,22,23,27,28
	ИЛИ-НЕ

	16. 
	4,5,7,8,13,21,18,19,22,21,28
	И, ИЛИ, НЕ


Тема №2
«Изучение графического пакета COROL DRAW».
(темы 1-6 из приведенного приложения)
Целью данной лабораторной работы является изучение стандартного графического пакета.

В рамках выполнения данной работы необходимо научиться выполнять действия в рассматриваемом графическом редакторе в объеме первых шести тем прилагаемого описания (см. Приложение 1).

При сдаче лабораторной работы необходимо предъявить преподавателю результаты выполнения задания по первой теме.

По материалам второй – шестой тем необходимо уметь выполнять  все операции, приведенных в разделе заданий описаний этих тем.  
 Сдача лабораторной работы осуществляется при явке студента в университет.

 Тема № 3

«Изучение графического пакета COROL DRAW».
(темы 7-11 из приведенного приложения)

Целью данной лабораторной работы является изучение стандартного графического пакета.

В рамках выполнения данной работы необходимо научиться выполнять операции  в рассматриваемом графическом редакторе в объеме  шестой – двенадцатой  тем прилагаемого описания (см. Приложение 1).

Перечень операций, которые необходимо освоить, приводится в заданиях, которыми заканчивается описание каждой темы в приведенном описании графического пакета.

Тема  №4
«Проекция динамической графической сцены».

Выполнение данной лабораторной работы предполагает построение аксонометрической проекции динамической графической сцены, состоящей из двух объектов: плоского треугольника и заданной заданного трехмерного объекта в виде призмы.

Треугольник задается произвольно, но он не должен занимать особое положение в системе координат (плоскость треугольника не должна быть параллельна координатным плоскостям). Положение треугольника должно меняться па заданной форме траектории таким образом, чтобы он в процессе перемещения пересекал заданную призму.  Необходимо обеспечить режим по шагового перемещения плоского треугольника.

Размеры  ребер призмы выбираются произвольно.

Вариант задания определяет:

· параметры проекции;

· вид траектории перемещения треугольника;

· вид призмы.

Варианты заданны в виде таблицы 2- 1.

Параметры проекции и вид траектории перемещения треугольника в таблице вариантов задаются в виде ссылок на таблицы «Параметры проекции» (таблица 2- 2) и таблицы 2- 3 «Вид траектории перемещения треугольника».

  Индивидуальные задания контрольной работы №2.           Таблица 1

	Параметры

варианта
	Номер варианта

	
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12
	13
	14

	вид проек. 
	т
	и
	д
	т
	и
	д
	и
	т
	и
	д
	т
	и
	д
	т

	пар.проек.
	1
	2
	3
	4
	5
	6
	1
	2
	3
	4
	5
	6
	1
	2

	вид призмы
	3
	4
	5
	3
	4
	5
	3
	4
	5
	3
	4
	5
	3
	4

	траектория
	1
	2
	3
	4
	2
	1
	2
	3
	4
	1
	2
	3
	4
	3

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	


Таблица 2 -2.Параметры проекции.  

	Параметры

проекции
	 Номер набора параметров 

	
	1
	2
	3
	4
	5
	6

	угол «а»
	300
	450
	600
	-300
	-450
	-600

	угол «b»
	-600
	-450
	-300
	600
	450
	300


Значения углов проекции «a» и «b» должны соответствовать описанию аксонометрической проекции в тексте лекций. 
Для диметрии используется только параметр угол «а».

Для изометрии параметры проекции не задаются.

 Таблица 2-3

	Вид траектории
	Код динамики

	Вращение относительно оси X
	1

	Вращение относительно оси Y
	2

	Вращение относительно оси Z
	3

	Перемещение по наклонной линии
	4


Линия, по которой перемещается треугольник, не должна быть параллельной ни одной из координатных осей. 

Для примера представим подробное описание индивидуального задания студента, зачетная книжка которого имеет № 560012-25.

№ варианта индивидуального задания  - 9,т.к. 25/16 =1 (остаток  9). Поэтому вариант соответствует девятой строке таблицы 6-1.

Вид проекции – изометрия (буква «и» в соответствующей строке таблицы 6-1).

Параметры проекции – отсутствуют (для изометрии нет различных вариантов углов вектора линии проекции к координатным осям и координатным плоскостям видовой системы координат (см. описание изометрии в тексте лекций).

Вид призмы  – пятиугольная призма.

Траектория перемещения плоского треугольника – перемещение по наклонной линии (4 в таблице 2-3).

Приложение 1
«COREL DRAW». Темы 1-6
Введение в векторную графику

Для хранения изображений существует большое количество программ с графическим форматом. Все они делятся на два основных вида: растровый и векторный.

В векторном формате изображение задается как совокупность отдельных объектов, описанных математически (например, как вектор на плоскости), а в растровом – по точкам, как мозаика.

Чтобы лучше понять разницу, можно привести пример как может быть описан один и тот же отрезок прямой: 

· в векторном формате – заданы координаты начала и конца, цвет и толщина;

· в растровом формате – заданы координаты каждой точки, входящей в этот отрезок, и ее цвет.

Векторный формат более компактный, но он совершенно не пригоден для хранения аналоговых изображений, например, фотографий. В этом формате задавать их математически было бы очень громоздко, поэтому гораздо проще использовать представление аналоговой графики в растровом виде. А вот рисунки и чертежи гораздо удобнее и практичнее делать именно в векторном виде. Его основными достоинствами являются следующие параметры:

· изменение масштаба без потери качества и практически без увеличения размеров исходного файла;

· огромная точность (до сотой доли микрона);

· небольшой размер файла по сравнению с растровыми изображениями;

· прекрасное качество печати;

· отсутствие проблем с экспортом векторного изображения в растровое;

· возможность редактирования каждого элемента изображения в отдельности.

Недостатки:

· практически невозможно экспортировать из растрового формата в векторное (можно, конечно, трассировать изображение, хотя получить хорошую векторную картину нелегко, когда графика черно-белая, почти невозможно, если изображение цветное);

· невозможно применение обширной библиотеки эффектов, используемых при работе с растровыми изображениями.

Написано большое количество программных продуктов, позволяющих рисовать векторные рисунки. Наиболее известным и универсальным среди них на сегодняшний день считается CorelDraw. На примере версии 7.0 этой программы мы и рассмотрим основные приемы работы с векторной графикой.




Тема 1 : CorelDraw. Создание простых объектов.

Рисование линий

В CorelDraw используются 2 режима рисования линий:

· Freehand (обычные кривые);

· Bezier (с использованием кривых Безье).

Режим рисования линий Freehand позволяет строить кривые линии с помощью мыши так же, как мы рисуем карандашом на бумаге. В режиме рисования Bezier указывается начальная и конечная точки дуги, а их соединение происходит автоматически.

Рассмотрим способ Freehand рисования прямых и кривых линий

1 Чтобы нарисовать прямую или кривую линию, выберите инструмент [image: image15.png]


 на панели инструментов Toolbox (Графика).

2 На рабочем поле нажмите левую кнопку мыши и, не отпуская ее, начинайте передвигать мышь. Отпустите левую кнопку мыши, и кривая останется на экране.

3 Чтобы нарисовать прямую линию, установите указатель мыши на свободное место, щелкните мышью и начните передвигать мышь. Щелкните еще раз, и отрезок останется на экране.

Чтобы нарисовать строго вертикальную ил горизонтальную линию, во время рисования следует нажать и держать нажатой клавишу Ctrl, в этом случае отрезок в процессе рисования будет поворачиваться с дискретным шагом в 15о.

Рисование кривых Безье

Для рисования кривой Безье перейдите в режим Bezier, выбрав инструмент [image: image16.bmp] во вспомогательной панели инструмента. Для этого нажмите кнопку [image: image17.png]


, расположенную на панели инструментов Toolbox (Графика), и если несколько мгновений не отпускать кнопку мыши, то на экране появится вспомогательная панель, содержащая несколько инструментов, щелкните мышью на кнопке [image: image18.bmp], кнопка [image: image19.png]


 будет заменена на [image: image20.bmp].

1 В рабочем поле нажмите и удерживайте левую кнопку мыши, передвиньте мышь. На экране появится пунктирная линия, длина и направление которой меняется с передвижением мыши. Эта пунктирная линия называется манипулятором кривизны. Отпустите кнопку мыши.

2 Передвиньте мышь, после чего снова нажмите кнопку мыши и удерживайте ее. Появится вторая пунктирная линия.

3 Дважды щелкните мышью для окончания построения кривой.

Рисование с помощью естественного пера

Существует возможность построения жирных линий как бы с помощью плакатных перьев. Инструмент для построения таких линий называется Natural Pen Tool (естественное перо).

Чтобы создать линию с помощью естественного пера, выберите инструмент [image: image21.bmp] во вспомогательной панели инструмента [image: image22.png]


. На панели инструментов Property Bar (Свойства) появится ряд управляющих элементов, с помощью которых можно настраивать естественное перо.

1 Выберите один из видов естественного пера, нажав соответствующую кнопку на панели инструментов Property Bar (Свойства).

2 В рабочем поле нажмите левую кнопку мыши и, не отпуская ее, начинайте передвигать мышь. На экране остается кривая, которая будет состоять из замкнутого контура без заливки.

В CorelDraw существует 4 вида естественного пера:

· Инструмент [image: image23.bmp] – Fixed Width Natural Pen Type (Естественное перо фиксированной ширины) предназначен для рисования линий постоянной толщины.

· Инструмент [image: image24.bmp] – Pressure Natural Pen Type (Давящее естественное перо) рисует линии с толщиной, зависящей от давления специального пера, применяемого для ввода. Если такого пера нет, то имитировать давление можно с клавиатуры.

· Инструмент [image: image25.bmp] – Calligraphie Natural Pen Type (Каллиграфическое естественное перо) создает линии, толщина которых зависит от наклона линии.

· Инструмент [image: image26.bmp] – Preset Natural Pen Type (Заготовка естественного пера) предназначена для рисования линий, толщина которых меняется от начала к концу линии в соответствии с созданной ранее заготовкой.

Размерные линии и выносные линии

Во вспомогательной панели инструмента [image: image27.png]


 находится инструмент [image: image28.bmp] для рисования выносных размеров и текстовых сносок. Данный инструмент очень удобно использовать для создания планов и чертежей.

После выбора инструмента [image: image29.bmp] появится ряд элементов для работы с размерными и выносными линиями. Чтобы нарисовать вертикальную размерную линию надо выбрать инструмент [image: image30.bmp], горизонтальную – [image: image31.bmp], или наклонную – [image: image32.bmp], угловые размеры – [image: image33.bmp]. 

Для рисования линейных выносных размеров необходимо выбрать один из указанных инструментов и щелкнуть мышью в трех точках: 1 – точка, от которой измеряется расстояние; 2 – точка, до которой измеряется расстояние; 3 – точка места расположения надписей с размером (размер вычисляется и отображается автоматически).

Для угловых размерных линий необходимо 4 раза щелкнуть мышью: 1 – в месте пересечения будущих размерных линий; 2 – в точке окончания первой размерной линии;   3 – в точке окончания второй размерной линии; 4 – в месте надписи с размером.

Кнопка [image: image34.bmp] позволяет выбрать стиль размещения надписей на размерных линиях. Нажав ее, откроется вспомогательная панель, в которой расположены 5 кнопок, позволяющих изменять взаимное расположение надписей и линий.

С помощью инструмента [image: image35.bmp] можно нарисовать выносные линии для схем, графиков и прочей документации.

Для рисования выносной линии, состоящей из двух сегментов, щелкните мышью в трех точках: точке начала линии, точке перегиба и точке, в которой будет начинаться текст. После третьего щелчка автоматически включится режим ввода текста.

Прямоугольники, квадраты и закругление углов

С помощью инструмента [image: image36.bmp] можно рисовать прямоугольники и квадраты, а также фигуры, похожие на прямоугольники, но с закругленными вершинами. Для облегчения построения правильных фигур нажмите и удерживайте клавишу Ctrl при построении. Если во время рисования прямоугольников или квадратов нажать клавишу Shift, то растягивание фигур будет происходить не от края, а от центральной точки.

Закруглить углы прямоугольника или квадрата можно с помощью управляющего элемента [image: image37.png]


, расположенного на панели инструментов Property Bar (Свойства).

Эллипсы, окружности, сектора, дуги

С помощью инструмента [image: image38.bmp] можно нарисовать эллипсы, окружности, сектора и дуги.

Если в процессе рисования вы будете держать нажатой клавишу Ctrl, то получите правильную окружность, а при нажатой клавише Shift растягивание фигуры будет происходить не от края, а от центральной точки.

Для преобразования эллипса в сектор или дугу и обратного преобразования предназначены три кнопки панели инструментов Property Bar (Свойства):

· Кнопка [image: image39.bmp] служит для преобразования эллипса или дуги в сектор.

· Кнопка [image: image40.bmp] предназначена для преобразования эллипса или сектора в дугу.

· Кнопка [image: image41.bmp] выполняет преобразование сектора или дуги в эллипс.

Нарисуйте эллипс, после чего нажмите соответствующую кнопку, и эллипс будет преобразован в сектор или дугу.

Для изменения угла наклона начала и конца этих элементов следует воспользоваться управляющим элементом [image: image42.png]“Mann vt
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.

Нажатием кнопки [image: image43.bmp] можно быстро изменить углы с точностью до наоборот.

Многоугольники, спирали, звезды, клетки

Создаются с помощью инструмента [image: image44.bmp], содержащего во вспомогательной панели три инструмента: [image: image45.bmp], [image: image46.bmp] и [image: image47.bmp].

Для рисования многоугольника выберите инструмент [image: image48.bmp] на панели инструментов Toolbox (Графика). Установите указатель мыши в точку одного из углов многоугольника, нажмите на левую кнопку мыши и, не отпуская ее, перемещайте к противоположному углу, после чего отпустите кнопку мыши. Если держать клавишу Ctrl, то получим правильный многоугольник.

Внешний вид объекта можно изменить с помощью управляющих элементов, расположенных на панели инструментов Property Bar (Свойства). Количество сторон многоугольника можно установить с помощью управляющего элемента [image: image49.png]Y26

|



. Если нажать кнопку [image: image50.bmp], вместо многоугольника будет создаваться звезда. Для звезд, имеющих более шести вершин, соединить вершины можно, пропуская одну, две или более вершин. Это число можно задать с помощью элемента [image: image51.png]Atz |



.

С помощью инструмента [image: image52.bmp] и [image: image53.bmp] можно рисовать спирали и клетки. Указатель мыши помещается в один угол объекта, нажимается левая кнопка мыши, и указатель мыши перемещается в противоположный угол.

Для клетки можно задать количество ячеек по горизонтали и по вертикали с помощью управляющего элемента [image: image54.png]


.

Чтобы задать число витков спирали – [image: image55.png]o



.

Если держать нажатой клавишу Ctrl, то получите фигуру правильной формы, а при нажатой клавише Shift – растягивание фигуры будет происходить не от края, а от центральной точки.

ЗАДАНИЯ

1 Создайте рисунок с помощью простых фигур (дом, луна или солнце, цветочная клумба, озеро и т.п.).

2 С помощью кривых Безье нарисуйте:

· на клумбе цветы;

· в озере рыб;

· на дереве птиц.

3 Нарисуйте с помощью кривых Безье “Медузу Горгону”.


 

Тема 2. Основные навыки работы с объектами.

Отмена и возврат действий

Отмена последнего действия – управляющий элемент [image: image56.png]


, расположенный на панели инструментов Standard (Основная).

При нажатии [image: image57.bmp] откроется список, в котором перечислены все последние действия. Выберите одно из действий и все операции, начиная с этого действия, будут отменены. Восстановить ранее отмененную операцию можно с помощью элемента [image: image58.png]


 

[image: image59.bmp] – возвращает одно отмененное действие.

[image: image60.bmp] – возвращает несколько отмененных ранее команд.

Команда меню Edit → Repeat (Правка → Повторить) позволяет перенести на другие объекты последнюю выполненную над любым объектом операцию.

Вместо выбора меню можно нажать комбинацию клавиш Ctrl+R.

Выделение и перемещение объектов

Для работы с уже существующим объектом надо его выделить с помощью инструмента [image: image61.bmp]. После выделения вы можете использовать средства редактирования и команды меню для изменения его внешнего вида и позиции на экране.

Для выделения всех объектов сразу дважды щелкните на кнопке [image: image62.bmp].

Для выделения объектов, которые имеют заливку, можно щелкнуть в любом месте внутри объекта.

Выделение нескольких объектов
1 Выделить первый объект.

2 Нажать Shift, не отпуская ее выделить все другие объекты, щелкая мышью последовательно на контуре каждого объекта. Отпустить Shift.

3 Нажать Shift, не отпуская ее щелкнуть на контуре одного из выделенных объектов. Выделение только этого объекта будет отменено. Отпустить Shift.

Если ваше изображение состоит из нескольких объектов и один из объектов выделен, то нажатием клавиши Tab выделяется следующий объект.

Если вы выделили несколько объектов и хотите отменить выделение одного из них, нажмите клавишу Shift и щелкните мышью на контуре данного объекта.

Перемещение, копирование и удаление объектов

Перемещение, копирование и удаление объектов являются основными операциями.

Переместить выделенный объект можно следующими способами:

1 С помощью мыши:

· левой кнопкой мыши нажать на контур или внутри объекта;

· не отпуская кнопки, передвигайте мышь, появятся пунктирные границы объекта;

· переместите рамку на нужное место, и отпустите кнопку мыши. Объект переместиться в нужное место.

Если необходимо переместить объект строго горизонтально или вертикально, то для этого достаточно нажать клавишу Ctrl и переместить объект с помощью мыши, как было описано выше.

2 С помощью клавиш управления курсором на клавиатуре компьютера: ↑, ↓, ←, →.

3 С помощью панели инструментов Property Bar (Свойства).

Чтобы удалить объект (несколько объектов), необходимо выделить их, а затем нажать клавишу Delete.

Если вы хотите создать копию объекта, то:

1 При перемещении объекта с помощью мыши, перед тем как отпустить левую кнопку мыши, щелкните ее правой кнопкой, или нажмите + на цифровой клавиатуре.

2 С помощью команд меню Edit → Dublicate и Edit → Clone (Правка → Дублировать) и (Правка → Клонировать).

Если вы работаете сразу с несколькими скопированными объектами, то иногда бывает трудно распознать, из какого оригинала получена данная копия. Чтобы определить, который из объектов является главным, а которые – копиями в группе объектов, используйте контекстное меню.

Если щелкнуть правой кнопкой мыши на главном объекте, появится меню с командой Select Clone (Выделить клоны), если щелкнуть на копии, то меню появится с командой Select Master (Выделить главный объект).

Объединение объектов в группы и разъединение

Для постоянной работы с несколькими объектами, как с одним, эти объекты объединяются в группу. Чтобы сгруппировать объекты, необходимо выделить предварительно каждый объект, а затем нажать Group (Сгруппировать) на панели инструментов Property Bar (Свойства).

Сгруппировать объекты можно с помощью комбинации клавиш Ctrl+G.

Чтобы разбить группу на отдельные объекты, выделите ее и нажмите кнопку Ungroup (Разгруппировать). Внешний вид объектов при этом не измениться, но строка состояния показывает N Object Select (Выбрано объектов N). После этого можно манипулировать с каждым объектом отдельно.

Разгруппировать объекты можно также с помощью комбинации клавиш Ctrl+U.

Если в группе находится другая группа, то разгруппировать все вложенные группы можно с помощью кнопки Ungroup All (Разгруппировать все).

Для выделения объекта в группе нажмите клавишу Ctrl и, удерживая ее, щелкните мышью на объекте, который вы хотите выделить. Далее вы можете применять к нему такие же параметры и преобразования, как и к любому другому объекту. После отмены выделения он снова становится частью группы, так что он будет подвержен всем операциям, которые вы производите с группой.

Соединение объектов

Под операцией соединения понимается объединение нескольких объектов в один новый объект. Операция выполняется с помощью кнопки Combine (Соединить) на панели инструментов Property Bar (Свойства).

Соединение отличается от группирования тем, что над группой объектов нельзя произвести все те же операции, как и над объектом. В результате соединения получается новый объект, над которым можно производить все без исключения операции.

Соединение объектов применяется для следующих целей:

· создание отверстий или цветовых масок;

· экономия памяти для рисунков, включающих много отрезков прямых и кривых;

· соединение нескольких отрезков в одну линию;

· выравнивание узлов в различных объектах.

Чтобы разделить соединенные объекты на исходные составляющие, выделите новый объект и нажмите кнопку [image: image63.bmp] на панели инструментов Property Bar (Свойства).

Логические операции

Имеются три команды для проведения операций над объектами:

· Intesection (Пересечение);

· Trim (Исключение);

· Weld (Объединение).

Эти операции выполняются с помощью кнопок [image: image64.bmp], [image: image65.bmp] и [image: image66.bmp], расположенных на панели инструментов Property Bar (Свойства). Также эти операции можно выполнить с помощью команд, которые вызываются их меню Arrange (Монтаж).

Weld (Объединение) создает новый объект, который повторяет только внешние контуры объединенных объектов (все внутренние элементы удаляются).

Intersection (Пересечение) – создается новый объект, включающий в себя область, общую для всех выделенных объектов. Новый объект сохраняет контур и заливка объекта, выделенного последним.

Trim (Исключение) – из исходных объектов вырезаются перекрывающиеся области. Если передвинуть объекты, видно, что пропали части, скрытые под другими объектами.

Порядок наложения объектов

Для применения порядка наложения объектов друг относительно друга на одном слое используются команды меню (Arrange → Order):
· To Font (На передний план);

· To Back (На задний план);

· Forward One (Вперед);

· In Font of (Перед объектом);

· Back One (Назад);

· Behind (После объекта);

· Reverse Order (Обратить порядок).

Необходимо выделить объект и выбрать команду.

ЗАДАНИЯ
1 Нарисуйте квадрат, правильный шестиугольник, звезду.

2 Удалите лишние фигуры, оставив на листе 2 квадрата, 2 шестиугольника, 2 звезды.

3 Разместите на новом листе фигуры следующим образом:

	квадрат
	шестиугольник
	звезда


	звезда
	квадрат
	шестиугольник


4 Объедините в три группы свои объекты, затем разъедините 2 группы, оставив 1 группу объединенной.

5 Соедините квадрат с шестиугольником, проанализируйте новый объект.

6 На новом листе создайте новые объекты используя имеющиеся объекты с помощью операции

· пересечение;

· исключение;

· объединение.

7 Из полученных новых объектов создайте новый объект путем наложения объектов.



Тема3: Привязка объектов

Выравнивание объектов

Чтобы выровнять объекты друг относительно друга, красиво расположить объекты, выделите нужные объекты, нажмите Align (Выровнять) или Arrange → Align and Distibure (Монтаж → Выровнять и распределить). Появится диалог Align and Distibure (Выровнять и распределить). Слева и сверху диалога расположены флажки, задающие тип выравнивания. С помощью флажков установите необходимое выравнивание.

Привязка объектов

Можно использовать команду меню Layout → Snap To (Макет → Привязать к), которая сделает так, чтобы сетка, вспомогательные линии и стационарные объекты вели себя подобно магнитам. Вновь создаваемые или редактируемые объекты притягиваются к другим объектам, вспомогательным линиям и сетке для точного выравнивания.

Вторым способом включения режима привязки объектов является использование кнопок панели инструментов Property Bar (Свойства).

[image: image67.bmp] – кнопка включает режим привязки к сетке.

[image: image68.bmp] – кнопка включает режим привязки к направляющим.

[image: image69.bmp] – кнопка включает режим привязки к другим объектам.

Привязка объектов к сетке

Команда меню Layout → Snap To Grid (Макет → Привязка к сетке) включает и выключает режим привязки объектов вертикально и горизонтально по ближайшему узлу сетки. Режим полезен при измерении объектов с помощью размерных линий, так как в этом режиме размерные линии притягиваются к началу и концу объектов.

Когда вы перемещаете объект при включенном режиме привязки к сетке черные квадраты выделяющегося прямоугольника притягиваются к ближайшему узлу сетки. Вы определяете, какой из восьми квадратов выравнивается по сетке, контролируя направление, в котором вы перемещаете объект.

Когда текст перемещается вертикально при включенном режиме привязки к сетке, то он выравнивается по сетке вдоль его базовой линии. При горизонтальном перемещении выравнивание определяется тем, как выровнен сам текст: вправо, влево или по центру. Если текст повернут, то для выравнивания его по сетке используйте квадраты выделяющего прямоугольника.

Привязка объектов к направляющим

Размещение объектов на экране не изменяется, когда вы выбираете команду меню Layout → Snap To Guidelines (Макет → Привязать к направляющим).

Когда включены оба режима – Привязка к сетке и Привязать к направляющим, то второй режим имеет приоритет. Не имеет значения, как близко проходит направляющая от линии сетки, вы всегда можете выровнять объект по направляющей.

Привязка объектов к другим объектам

Выбрав команду меню Layout → Snap To Object (Макет → Привязать к объектам) вы можете притягивать выбранный объект к другим объектам.

Все объекты имеют точки привязки, связанные с ними. Когда выбрана команда меню Привязать к объектам, каждая точка привязки каждого объекта имеет действие гравитации точно так же, как сетка и вспомогательные линии. Эта гравитация имеет ограниченную область, которая называется расстоянием фиксации на экране.

Точки привязки на объектах

	[image: image70.png]



	Простые прямоугольники имеют 9 точек привязки

	[image: image71.png]



	Прямоугольники с закругленными углами имеют 13 точек привязки
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	Замкнутые эллипсы имеют 5 точек привязки

	[image: image73.png]



	Сектора и дуги могут иметь в любом месте от 3 до 7 точек привязки

	[image: image74.png]



	Многоугольники имеют точки привязки: по одной на каждом углу, по одной на середине каждой стороны и одну в центре ограничивающей рамки многоугольника

	[image: image75.png]



	Звезды имеют точки привязки: по одной на каждой вершине, по одной на середине каждой внутренней стороны и одну в центре звезды
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	Клетки имеют точки привязки: по одной на каждом пересечении линий клетки, по одной на каждой линии клетки и по одной в центре каждой ячейки клетки

	[image: image77.png]



	Спирали имеют точки привязки на пересечении спирали с воображаемыми осями координат, проходящими через центр спирали
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	Открытые линейные пути имеют точки привязки на каждом конце и в каждом узле 
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	Точки привязки для растровых изображений существуют в каждом углу растрового изображения и в центре его ограничивающей рамки

	[image: image80.png]



	Фигурный текст имеет точки привязки в четырех углах ограничивающей рамки текста, в середине каждой из сторон ограничивающей рамки и одну в ее центре. Еще 2 точки привязки, где пересекаются базовая линия первой строки текста с ограничивающей рамкой

	[image: image81.png]



	Обычный текст имеет точки привязки по углам и в середине каждой стороны рамки обычного текста и одну в центре ограничивающей рамки


Произвольные фигуры, построенные с помощью естественного пера или созданные любым другим способом, имеют точки привязки во всех узлах.

ЗАДАНИЯ

1 Нарисуйте 4 квадрата, 1 круг, 4 ромба.

2 Симметрично расположите объекты

	квадрат
	ромб
	квадрат

	ромб
	круг
	ромб

	квадрат
	ромб
	квадрат


3 Включите режим привязки к сетке, проанализируйте, как ведут себя объекты при редактировании.

4 Включите режим привязки к направляющим, проанализируйте, как ведут себя объекты при создании и редактировании.

5 Включите режим привязки к другим объектам, проанализируйте, как ведут себя объекты при создании и редактировании.



Тема 4: Увеличение, уменьшение, вращение, перекрашивание объектов

Изменение размера объекта
1 Выделите объект. Подведите указатель мыши к нижнему правому прямоугольнику (с [image: image82.bmp] на  + ).

2 Нажать левую кнопку мыши и, не отпуская ее, передвигайте правее и ниже. Объект будет увеличен, при этом пропорции его сохраняются. Чтобы уменьшить объект, необходимо передвигать мышь в противоположном направлении.

Если в процессе изменения размера объекта нажать и удерживать Shift, то изменения размера будут происходить относительно центра объекта.

Для изменения размера объекта только по горизонтали или только по вертикали следует выполнять аналогичные действия с черными прямоугольниками, расположенными посередине сторон обрамляющей рамки.

Изменение размера объекта с помощью панели инструментов Property Bar (Свойства)
1 Выделите объект.

2 С помощью элемента [image: image83.png]2000 pm.
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 установите новые размеры объекта.

Еще одним способом уменьшения или увеличения объекта является использование команд меню Arrange → Transform → Size (Монтаж → Преобразовать → Размер). На экране появится свиток Size (Размер), в котором вы можете установить новые значения ширины и высоты объекта.

Вращение и перекашивание объектов

Объекты можно вращать по часовой стрелке или против нее, а также перекашивать объекты с помощью мыши или путем ввода соответствующих значений в свитках, вызываемых по команде меню Arrange → Transform (Монтаж → Преобразовать).

Можно повернуть объект с помощью элементов панели инструментов Property Bar (Свойства). Для этого:

1 Выделите объект.

2 С помощью элемента [image: image84.png]200



 задайте угол поворота.

Если один раз щелкнуть мышью на контуре объекта, то появится прямоугольник выделения, состоящий из восьми черных квадратов. Если щелкнуть еще раз, то по периметру объекта появятся стрелки. Стрелки по углам служат для вращения объекта, стрелки по сторонам используются для его деформации.

Перекос объектов:

	[image: image85.png]



	[image: image86.png]
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	исходный прямоугольник
	результат операции перекоса


Различают вертикальный и горизонтальный перекос.

Перекос объектов с помощью мыши
1 Выделить объект так, чтобы вокруг него появились стрелки.

2 Подвести указатель мыши к верхней стрелке ↔, нажать левую кнопку и, не отпуская передвигать мышь. Вокруг объекта появится пунктирная рамка.

3 Установите нужное положение пунктирной рамки и отпустите мышь.

Для выполнения вертикального переноса следует использовать стрелку ↨.

Чтобы создать дубликат первоначального объекта, перед тем как отпустить левую кнопку мыши, щелкните правой кнопкой или нажмите клавишу + на цифровой клавиатуре.

Поворот объекта

Для поворота используются стрелки [image: image88.bmp], [image: image89.bmp], [image: image90.bmp], [image: image91.bmp].  [image: image92.bmp] – центр вращения.

Для простого поворота надо подвести указатель мыши к стрелке [image: image93.bmp], нажмите левую кнопку и, не отпуская ее, передвигайте мышь.

Для более сложного поворота можно изменить расположение центра вращения: указатель мыши установите на центре вращения, нажмите левую кнопку и передвигайте мышь. Выбрав новое положение центра вращения, отпустите кнопку мыши.

Если необходимо создать дубликат и оставить первоначальный объект на месте – Apply To Duplicate (Применить к дубликату).

Если надо повернуть сам объект – Apply (Применить).

Если необходимо повернуть несколько объектов вокруг одной центральной точки, то необходимо сначала их сгруппировать. Затем установит центр вращения так, как будто группа является одним объектом.

Задания
1 Создайте объект. Сделайте несколько копий объекта.

2 Измените размеры скопированного объекта:

· только по вертикали (с помощью мыши);

· только по горизонтали (с помощью мыши);

· по горизонтали и вертикали с помощью панели инструментов.

3 Создайте перекос объекта.

· вертикальный с помощью мыши;

· горизонтальный с помощью мыши.

4 Поверните объект на любой угол, при этом первоначальный объект оставьте на месте.

5 Измените расположение центра вращения и сделайте задание в п.4.

6 Сгруппируйте объекты, затем поверните их вокруг одной центральной точки.



	Тема 5
	Зеркальное отображение. 

Работа с узлами различных объектов.

Изменение формы простых объектов.


Зеркальное отображение

Если при изменении размера объекта с помощью мыши уменьшать размер объекта до нуля, и, не останавливаясь, передвигать мышь дальше, через границу объекта как бы выворачивая его, то можно получить зеркальное отображение объекта.

Чтобы создать зеркальный дубликат объекта и сохранить его оригинал, зеркальное отображение которого вы хотите получить, перед тем как отпустить левую кнопку мыши, щелкните ее правой кнопкой.

Чтобы при зеркальном отображении сохранить размеры исходного объекта, нажмите и не отпускайте Ctrl во время операции.

Можно изменить центр зеркального отображения, если щелкнуть мышью на кнопке 
[image: image94.png]


.

Для изменения размеров зеркальных отображений введите значения в H (горизонтальном) и V (вертикальном) полях ввода. При установленном флажке Proportional (Пропорционально) достаточно ввести одно значение, и другое изменится автоматически.

Работа с узлами различных объектов

Выделенные объекты можно перемещать, масштабировать, растягивать, вращать, перетаскивать и отражать. Эти операции преобразуют объект без изменения его основной формы. Чтобы изменить основную форму объекта надо воспользоваться специальным инструментом [image: image95.bmp]. Сего помощью можно:

· закруглять углы прямоугольника;

· создавать дуги и сектора из эллипсов;

· произвольно изменять форму кривых линий;

· изменять форму многоугольников и звезд.

Изменение формы объектов связано с изменением взаимного расположения и количества узлов, а также кривизны сегментов. В зависимости от способа редактирования объекты делятся на две группы.

Первая группа – это все объекты, которые состоят их кривых линий. Их можно редактировать произвольно.

Вторая группа – это стандартные объекты (прямоугольники, эллипсы, многоугольники, звезды). Форму этих объектов можно изменить только в соответствии с определенным алгоритмом. Например: из эллипса нельзя сразу создать форму груши; для этого сначала необходимо преобразовать эллипс в кривые линии. 

Для произвольного редактирования сегментов и узлов необходимо преобразовать объект в кривые линии.

Приемы выделения узлов.

1 С помощью инструмента [image: image96.bmp] нарисуйте произвольную кривую и выделите ее.

При выборе инструмента [image: image97.bmp] черные прямоугольники обрамления пропадут, а узлы выделенного объекта будут отмечены маленькими квадратными рамками. Выделите любой узел, щелкнув на нем мышью. Выделенный узел отмечается черным прямоугольником. Отмените выделение узла. 

2 Нажмите Shift и, не отпуская ее, щелкните последовательно на нескольких узлах. Все узлы выделены. Отмените выделение узлов.

3 Установите указатель мыши на свободном пространстве, нажмите левую кнопку мыши и, не отпуская ее, начните передвигать мышь. Появится пунктирная рамка, размер которой будет меняться с передвижением мыши. Нарисуйте рамку так, чтобы в нее попало несколько узлов, отпустите кнопку мыши. Узлы выделены. Снимите выделение.

Одновременно можно выделить узлы только одного объекта.

Изменение формы простых объектов

Закругление углов прямоугольника.

1 Нарисуйте прямоугольник.

2 Нажмите кнопку [image: image98.bmp] на панели Toolbox (Графика) и подведите указатель мыши к одному из узлов, расположенных в вершинах прямоугольника. Нажмите левую кнопку мыши и, не отпуская ее, начните передвигать мышь. Вместе с указателем начнут передвигаться узлы.

3 Переместив узлы, отпустите кнопку мыши. Узлы закруглятся.

Создание дуг и секторов из эллипса.

1 Нарисуйте эллипс.

2 Нажмите [image: image99.bmp], а указатель мыши установите на узел в верхней части эллипса.

3 Нажмите левую кнопку и, не отпуская ее, передвигайте мышь, не выводя указатель мыши за границу эллипса.

4 Отпустите кнопку, получится сектор.

Если, передвигая мышь в п.3 вы переместите указатель мыши за пределы эллипса, линии внутри объекта пропадут, и получится дуга.

Редактирование многоугольников.

1 Нарисуйте произвольный многоугольник.

2 С помощью инструмента [image: image100.bmp] выделите объект.

3 Установите указатель мыши на узле в вершине многоугольника или звезды.

4 Нажмите и удерживайте левую кнопку мыши, перемещайте указатель в произвольном направлении. Когда переместите узел на требуемую позицию, отпустите кнопку.

Часто для произвольного изменения формы фигуры ее следует преобразовать в кривую линию. Можно преобразовать фигурный текст в кривые линии. Чтобы преобразовать прямоугольники, эллипсы, многоугольники, звезды и фигурный текст в кривые линии, выделите объект и выберите команду меню Arrange → Convert to Curves (Монтаж → Преобразовать в кривые). Она преобразует каждую часть выделенного объекта в отдельную кривую или прямую линию таким образом, что вы можете использовать инструмент [image: image101.bmp] для произвольного изменения формы. Для преобразования выделенного объекта в кривые линии можно также нажать кнопку [image: image102.bmp] панели Property Bar (Свойства).

Текстовую строку преобразованную в кривые линии нельзя больше редактировать, используя текстовые команды.

Задания

1 Создайте объект (цветок, машина, Чебурашка и т.п.).

· создайте зеркальное отображение, сохраняя первоначальный дубликат;

· измените центр зеркального отображения, отобразите объект без сохранения первоначального дубликата;

· создайте зеркальное отображение с изменением размеров зеркального отображения.

2 С помощью инструмента [image: image103.bmp]:

· закруглите углы прямоугольника;

· создайте дуги и сектор из эллипса;

· отредактируйте звезду по своему усмотрению.

3 Напишите слово ИНФОРМАТИКА. Преобразуйте текстовую строку в кривые линии. Попробуйте отредактировать ее.



Тема 6: Редактирование формы произвольных кривых
Чтобы получить достаточно сложный объект, возникает необходимость добавления, удаления или объединения узлов, разрыва и соединения контура.

Инструмент [image: image104.bmp] позволяет изменить основную форму кривой. Выбрав этот инструмент, вы можете редактировать узлы с помощью панели Property Bar (Свойства).

[image: image105.png]Ml TIA M mABIC ;2%




Существует три разновидности узлов:

· Гладкие узлы. У гладкого узла два манипулятора кривизны всегда расположены на одной прямой, но на разном расстоянии от узла, т.к. радиусы кривизны с разных сторон различны. Кривая линия не имеет перегиба в гладком узле (при перемещении одного из манипулятора, другой также перемещается).

· Симметричные узлы. Манипуляторы кривизны расположены на одной прямой и равноудалены от узла. Можно сделать симметричными те узлы, которые соединяют две кривые линии. При перемещении одного манипулятора, другой автоматически перемещается на тоже расстояние в противоположном направлении.

· Точки перегиба. У узлов – точек перегиба оба манипулятора кривизны и сам узел не обязательно должны находиться на одной прямой линии. Манипуляторы можно перемещать независимо друг от друга. Можно сделать узел точкой перегиба, если надо изменить направление кривой в узле.

Чтобы изменить тип узла, необходимо выделить его и нажать кнопку:

· Cups (Точка перегиба) или [image: image106.bmp]– чтобы преобразовать выделенный узел в точку перегиба;

· Smooth (Гладкий) или [image: image107.bmp] – чтобы преобразовать узел в гладкий;

· Symmet (Симметричный) или [image: image108.bmp] – для преобразования узла в симметричный

Можно изменить тип нескольких узлов, предварительно выделив их.

Существует два типа сегментов: кривых и прямых линий. Сегмент кривой линии имеет два манипулятора кривизны, связанных с ним, по одному для каждого узла. Сегмент прямой линии представляет собой прямую линию, связанную с двумя узлами. Можно преобразовать сегменты кривых линий в сегменты прямых и наоборот. 

Чтобы изменить тип сегмента, щелкните мышью на кнопке:

· To Line (В прямую) или [image: image109.bmp] – преобразовать в прямую линию;

· To Curve (В кривую) или [image: image110.bmp] – преобразовать в кривую линию.

Перемещение узлов

Чтобы изменить форму кривой линии, переместите сегменты, узлы или манипуляторы кривизны, которые содержатся в ней.

Во время перемещения помните о следующем:

· Кривая линия всегда проходит через узлы.

· Форма кривой линии между узлами определяется манипуляторами кривизны для двух узлов.

· Каждый узел имеет 2 манипулятора кривизны, кроме узлов на конце кривой линии.

· Манипуляторы кривизны определяют узел, под которым кривая линия входит в узел.

· Чем дальше манипулятор кривизны от узла, тем больше кривизна линии.

· Чем ближе манипулятор к узлу, тем меньше кривизна линии.

· Если манипулятор размещен поверх узла, то он не оказывает никакого влияния на форму и направление кривой линии.

Чтобы переместить узел или сегмент кривой линии, выполните следующие действия.

1 Используя инструмент [image: image111.bmp], установите указатель мыши на узле или сегменте, который вы хотите передвинуть.

2 Нажмите и удерживайте левую кнопку мыши на узле или сегменте.

3 Переместите указатель мыши в нужную позицию и отпустите кнопку мыши.

Когда перемещается узел, манипуляторы перемещаются вместе с ним таким образом, что степень кривизны на узле остается неизменной, т.е. угол, под которым кривая линия входит и выходит из узла, остается неизменным.

Если держать нажатой клавишу Ctrl во время перемещения узла или манипулятора кривизны, то движение будет ограничено по вертикали или горизонтали.

Чтобы одновременно переместить несколько узлов и сегментов надо:

1 Выделить узлы с помощью штриховой рамки или, нажав Shift и щелкая мышью на нужных узлах.

2 Установите указатель мыши на одном из выделенных узлов.

3 Нажмите и удерживайте левую кнопку мыши.

4 Переместите узел на нужную позицию. При этом другие выделенные узлы также переместятся.

Чтобы изменить кривизну сегмента надо:

1 Щелкнуть мышью на узле.

2 Установить указатель мыши на манипуляторе, который вы хотите переместить.

3 Нажав и удерживая левую кнопку мыши, перемещайте указатель до тех пор, пока кривая линия не примет требуемой формы.

4 Отпустите кнопку мыши.

Вставка и удаление узлов

Если вы не можете получить требуемую форму с существующими узлами, необходимо добавите больше узлов.
I способ:

1 Щелкните мышью в том месте сегмента, где вы хотите добавить узел. В этом месте появится черный кружок.

2 Нажмите кнопку [image: image112.bmp] или нажмите + на цифровой клавиатуре. Узел будет добавлен.

II способ:

1 Выделите узлы, следом за которыми вы хотите добавить новые узлы.

2 Нажмите кнопку [image: image113.bmp] или + на цифровой клавиатуре. В этом случае новые узлы будут созданы в середине сегментов, причем число новых узлов будет равно числу предварительно выделенных.

Существует 3 основных правила для определения необходимого количества узлов.

· Для кривых типа дуги эллипса вам нужен узел приблизительно каждые 120о.

· Для кривых линий, плавно изменяющих направление между вершинами, вам нужен один узел, по крайней мере, для каждых двух точек перегиба. Точка перегиба – это точка, на которой меняется направление кривой линии.

· Для кривых линий, изменяющих направление на вершине, вам нужен узел для каждой вершины.

Чтобы удалить узлы и сегменты надо:

1 Используя инструмент [image: image114.bmp], выделить узел или узлы, который надо удалить.

2 Нажать кнопку [image: image115.bmp] или Delete или – на цифровой клавиатуре. Выделенные узлы удаляются, и кривая перерисовывается.

Способы редактирования формы объектов

Вы можете соединить 2 конечных узла, чтобы замкнуть кривую или создать одну кривую из двух.

Чтобы замкнуть открытую кривую, надо:

1 С помощью инструмента [image: image116.bmp] выделите 2 конечных узла.

2 Нажмите [image: image117.bmp] или[image: image118.bmp]. Кнопка [image: image119.bmp] сделает из двух узлов один путем соединения узлов, а [image: image120.bmp] нарисует прямую линию между узлами.

Самый быстрый способ замыкания контура объекта: при работе с инструментом [image: image121.bmp] или [image: image122.bmp] нажмите кнопку Auto-Close (Автоматически закрыть) панели Property Bar (Свойства), и контур выделенного объекта будет замкнут.

Сделать одну непрерывную кривую линию из отдельных частей можно с помощью инструмента [image: image123.bmp] и затем выбрать команду меню Arrange → Combine (Монтаж → Соединить).

Чтобы разорвать линию, надо:

1 Используя [image: image124.bmp], щелкните на узле.

2 Нажмите [image: image125.bmp]. Кривая разорвется в выделенных узлах. Два несвязанных узла будут точно наложены друг на друга в этой точке. Можно переместить любой из них.

Несмотря на то, что кривая может быть разделена на несколько фрагментов, это все еще единый объект. Чтобы разделить его на несколько отдельных независимых объектов, выберите команду меню Arrange → Break Apart (Монтаж → Разъединить).

Для выравнивания узлов двух объектов надо:

1 С помощью [image: image126.bmp] выделить два объекта, узлы которых вы хотите выровнять.

2 Выбрать команду меню Arrange → Combine (Монтаж → Соединить).

3 Выбрать [image: image127.bmp].

4 Щелкнуть на узле, который вы хотите выровнять.

5 Нажмите Shift и, удерживая ее, щелкните на узле другого объекта, с которым вы хотите выровнять уже выделенный узел.

6 Нажмите кнопку [image: image128.bmp] для выравнивания двух выделенных узлов. На экране появится диалог Node Aligh (Выравнивание узлов). В этом диалоге задается тип выравнивания.

7 После установки флажков закройте диалог.

8 Повторите данную операцию с остальными узлами, которые вы хотите выровнять.

9 Разделите объекты, выделив узел одного из объектов и нажав кнопку [image: image129.bmp]. Получите два объекта с совпадающими контурами.

Задания

1 Нарисуйте эллипс, растянутый в вертикальном направлении.

2 Выделите эллипс и преобразуйте его в кривые.

3 Измените форму объекта таким образом, чтобы он стал похож на яйцо.

4 С помощью манипуляторов кривизны правого и левого узлов добейтесь, чтобы объект стал похож на грушу.

5 Немного увеличьте длину манипулятора кривизны верхнего угла, чтобы верх кривой стал более пологим.

6 Вставьте новые узлы ниже средних узлов с правой и левой стороны объектов.

7 Выделите 3 нижних узла, передвиньте их вверх, чтобы добиться формы колокола.

8 Удалите верхний угол на правой и левой сторонах. Вместо колокола получится форма, напоминающая наконечник копья.

9 Разорвите контур в узле на правой (левой) стороне и разнесите узлы в месте разрыва.

10 Создайте дополнительные узлы немного выше двух конечных узлов в месте разрыва.

11 Объедините 2 конечных узла верхнего фрагмента в один (с каждой из сторон).

12 Переместите новый узел вверх и щелкните на черном цвете в палитре для заливки объекта.

13 Нарисуйте ломаную линию, имитирующую зубы акулы. Получилось нечто, напоминающее пасть акулы.

14 С помощью инструмента [image: image130.bmp] переместите вершины ломаной линии, чтобы подровнять зубы акулы. Получился оригинальный значок «Осторожно, злая акула» из простого эллипса.

15 Создайте свой значок с помощью редактирования формы произвольных кривых.




Приложение 2
«COREL DRAW». Темы 1-11
Тема7: Приемы работы с контурами объектов. Способы обрезки объектов
Способы обрезки объектов

Редактировать форму объектов можно, используя инструменты [image: image131.bmp] и [image: image132.bmp], находящиеся во вспомогательной панели инструмента [image: image133.bmp].

[image: image134.bmp] – предназначен для разделения объекта на части. Выбрав этот инструмент, щелкните последовательно на точках разрыва контура объекта. Объект будет разделен на две части.

Если нажать кнопку [image: image135.bmp] панели Property Bar (Свойства), то точки разрыва будут соединены новой линией и контур объекта будет замкнут, а если отжать эту кнопку, то новая линия не будет добавляться и контур останется разорванным.

Когда нажата кнопка [image: image136.bmp] панели Property Bar (Свойства), то после разреза обе части составят один объект; если же эта кнопка отжата, то будут созданы два новых объекта.

Инструмент [image: image137.bmp] предназначен для удаления элементов объекта. Выбрав этот инструмент, вы просто стираете рисунки мышью.

Можно удалить часть объекта таким образом, что объект будет содержать несколько пересекающихся частей. Размер полосы стирания можно отрегулировать с помощью управляющего элемента [image: image138.png]& 1.0



.

Различные виды контуров

Контур объекта имеет толщину, цвет, форму углов и форму окончания линий.

CorelDraw 7 предоставляет несколько способов для выбора атрибутов контуров: вспомогательная панель, свиток, палитра справа рабочего экрана, панель Property Bar (Свойства) и диалоги. Независимо от метода сначала с помощью инструмента [image: image139.bmp] выделите объект, контур которого вы хотите изменить, а затем установите атрибуты контура.

Вспомогательная панель инструмента [image: image140.bmp] дает быстрый доступ к различно ширине контура, который установлен заранее, а также кнопку [image: image141.bmp] для удаления атрибутов контура. Это меню появится, если щелкнуть мышью на инструменте [image: image142.bmp] панели инструментов Toolbox (Графика).

Экранная цветовая палитра позволяет выбрать цвет контура с помощью мыши.

Свиток Pen (Перо) можно открыть, щелкнув мышью на [image: image143.bmp] во вспомогательной панели инструмента [image: image144.bmp]. Свиток Pen (Перо) используется для выбора толщины и внешнего вида линии, формы окончания линии и стрелок.

Диалоги Outline Pen (Перо для контуров) и Outline Color (Цвет контура) дают доступ ко всем имеющимся атрибутам контура, а также позволяют определить некоторые параметры с цифровой точностью.

Редактирование свойств контура объекта

Если нажать [image: image145.bmp], расположенную на панели инструментов Toolbox (Графика), то откроется вспомогательная панель инструментов для работы с контурами объектов [image: image146.png]


.

Если нажать [image: image147.bmp], контур объекта будет удален.

Разная толщина контура устанавливается с помощью кнопок [image: image148.bmp], [image: image149.bmp], [image: image150.bmp], [image: image151.bmp], [image: image152.bmp].

Если вы выделили произвольную кривую линию, а не объект типа прямоугольника, эллипса, многоугольника или текста, в панели инструментов Property Bar (Свойства) появится открывающийся список [image: image153.png]@ |Haiine v



. Открыв список, вы можете выбрать None (Нет контура), Hairline (Сверхтонкий контур) или установить требуемую толщину контура.

Чтобы изменить атрибуты контура с помощью диалога Outline Pen (Перо для контура) надо в раскрывшейся вспомогательной панели щелкнуть на кнопке с изображением пера. Появится диалог Outline Pen (Перо для контура). Рассмотрим поля диалога:

Color (Цвет). Чтобы открыть диалог Outline Color (Цвет контура), щелкните мышью на кнопке Other (Другие) в цветовой палитре. Вы сможете создавать цвета и давать им названия.

Arrows (Стрелки). Под стрелками подразумеваются самые разные рисунки вне зависимости от их внешнего вида, которые располагаются на концах линий. В секции Arrows (Стрелки) существует два поля ввода, которые показывают тип стрелок, выбранных в настоящее время. Чтобы выбрать стрелку в начале линии, щелкните мышью на левом поле ввода, а затем в окне на выбранной стрелке. Для выбора типа стрелки в конце – правое поле ввода.

Можно создавать ваши собственные стрелки с помощью команды меню Tools → Create → Arrow (Сервис → Создать → Стрелка).

Чтобы поменять начальные и конечные стрелки местами, щелкните мышью на любой из кнопок Options (Меню), а затем Swap (Перенести), Edit (Изменить), вы можете отредактировать вид стрелки.

Для удаления стрелки из линии щелкните на соответствующем поле ввода в секции Arrows (Стрелки) и выберите линию без стрелки.

Width (Толщина). Введите в это поле с помощью клавиатуры или выберите с помощью кнопок [image: image154.bmp] и [image: image155.bmp] толщину линии по вашему желанию. Для использования других единиц измерения выберите их из поля ввода единиц измерения.

Corners (Углы). Этот переключатель предлагает вам три варианта выбора для рисования контуров, которые содержат острые углы.

· Первый вариант [image: image156.png]


 рисует остроконечную вершину, в которой наружные края двух соединений линий простираются до тех пор, пока не встретятся.

· Второй вариант [image: image157.png]


 закругляет точку, в которой встречаются две линии.

· Третий вариант [image: image158.bmp] срезает угол соединения линий контура.

Line Caps (Отрезки). Этот переключатель предлагает вам три формы окончания линии.

· Первый вариант [image: image159.bmp] срезает линию в конечной точке.

· Второй вариант [image: image160.bmp] создает полукруглую дугу с диаметром, равным толщине линии в конечной точке.

· Третий вариант [image: image161.bmp] срезает линию и продолжает ее за конечную точку на расстояние, равное половине толщины линии.

Style (Вид). Щелкнув мышью на элементе Style (Вид), вы увидите список стилей штриховых и пунктирных линий, которые вы можете использовать для рисования контура выделенного объекта. Чтобы выбрать внешний вид линии, надо щелкнуть на нем мышью.

Calligraphy (Каллиграфия). Каллиграфические контуры варьируются по толщине, как при письме мягкой перьевой ручкой.

Behind Fill (Заливка выше контура). Чтобы нарисовать контур объекта под его заливкой, установите флажок Behind Fill. Эффект особенно заметен при работе с более толстыми контурами.

Scale with Image (Сохранять пропорции). При установке этого флажка автоматически изменяется контур объекта при его масштабировании.

При вращении объекта и установленном угол флажке Scale with Image (Сохранять пропорции) угол формы пера, используемый для каллиграфических эффектов, вращаются вместе с объектом так, что внешний вид объекта остается неизменным. Если этот параметр включен, толщина контура объекта не меняется, когда вы масштабируете объект, и его внешний вид может изменяться.

Копирование свойств контура и удаление контура

Чтобы удалить контур выделенного объекта, нажмите кнопку [image: image162.bmp] из вспомогательной панели инструмента [image: image163.bmp]. Контур объекта удалится, останется видимой только его заливка.

Для удаления контура объекта с помощью свитка Pen (Перо) в поле ввода толщины линии щелкайте мышью на стрелке прокрутки до тех пор, пока не появится перекрестие. Это означает отсутствие контура. Щелкните мышью на Apply (Применить) для удаления контура выделенного объекта.

Чтобы скопировать контур объекта с помощью меню, надо:

1 Выделить объект [image: image164.bmp].

2 Выбрать команду меню Edit → Copy Properties From (Правка → Копировать свойства).

3 В диалоге Copy Properties From (Копировать свойства) установите флажок Outline Pen (Атрибуты контура) и/или Outline Color (Цвет контура).

4 Указатель мыши изменится на [image: image165.bmp]. Щелкните на объекте, с которого вы хотите скопировать атрибуты (источник). Специальный указатель мыши [image: image166.bmp] будет оставаться на экране до тех пор, пока вы не выберите объект-источник. Когда вы выбрали объект-источник, атрибуты его контура будут присвоены объекту назначения.

Чтобы скопировать контур объекта с помощью правой кнопки мыши, надо:

1 Подвести указатель мыши к контуру объекта-источника, нажать правую кнопку и, не отпуская ее, начать передвигать мышь.

2 Подвести указатель к контуру объекта, который хотите отредактировать. Отпустить кнопку. На экране появится меню, которое предлагает выбор возможных действий.

3 Выберите команду меню Copy Outline Here (Скопировать контур) и контур второго объекта будет изменен в соответствии с внешним видом контура первого.

Атрибуты контура скопируются на выделенный объект назначения.

Каллиграфический контур

Внизу диалога Outline Pen (Перо для контура) находятся поля каллиграфии для управления формой пера. Они позволяют создавать каллиграфические эффекты для контуров объектов.

Обычно форма пера – квадрат определенной толщины. Можно сделать контуры толще или тоньше и изменить угол контура, варьируя значения в полях ввода Stretch (Растяжение) и Angle (Угол). Чтобы растянуть и уменьшить площадь пера контура, введите значение в процентах в поле Stretch (Растяжение) (по умолчанию – 100%). Для изменения ориентации пера, введите новое значение в поле Angle (Угол) (по умолчанию – 0о).

В поле Nib Shape (Форма кисти) можно изменить ширину и угол пера в интерактивном режиме.

Если вы измените установку Corners (Углы) на закругленные углы, форма пера изменится на эллипс.

Задания

1 Нарисуйте цветочный букет, разделите его на две части.

2 Удалите по своему усмотрению часть объекта таким образом, чтобы объект содержал несколько непересекающихся частей.

3 Скопируйте несколько объектов.

4 Установите для каждого объекта свою толщину контура.

5 Создайте свои собственные стрелки, расположите их на концах линий ваших объектов.

6 В своих объектах острые углы оформите как:

· остроконечную вершину;

· закругленную вершину;

· срезанный угол.

7 Произведите заливку объекта выше контура.

8 Создайте новый объект, скопируйте свойства контура с ранее созданного объекта на новый.

9 Каллиграфическим контуром “Как с гуся вода”.



Тема 8: Выбор цвета для объектов и их контуров
Модели представления цвета

Печать представляет собой процесс наложения краски на бумагу или другую поверхность. Краски делятся на две категории стандартизированных цветов, или плашечные (Spot color inks) и составных цветов (Process color inks).

Spot Color Inks (Плашечные цвета). Краски плашечных цветов непрозрачны. Смешивание плашечных цветов приводит к непредсказуемым результатам.

Process Color Inks (Составные цвета). Краски составных цветов прозрачны и предназначены для получения новых оттенков и цветов при смешивании. Свет проходит сквозь краски и фильтруется.

Выбор цвета для объектов и их контуров

Самый простой способ залить объект и раскрасить контур заключается в использовании палитры цветов, которая по умолчанию располагается с правой стороны рабочего окна и содержит цвета CMYK (Бирюзовый, Пурпурный, Желтый, Черный) модели.

Чтобы выбрать цвет для объекта и контур из палитры:

1 Выделите объект.

2 Убедитесь, что включен один из режимов полноцветного просмотра, например, Normal View (Обычный просмотр). Или выберите нужный режим из списка на панели Standard (Стандартная).

3 Выберите цвет из палитры.

Если вы хотите удалить заливку, т.е. сделать объект прозрачным, щелкните на ячейке [image: image167.bmp].

Выбор цветов из специального диалога позволяет получить доступ к любому цвету любой цветовой модели.

· Выделите объект и щелкните на [image: image168.bmp] во вспомогательной панели инструмента [image: image169.bmp]. На экране появится диалог Uniform Fill (Однородная заливка). Подобный диалог Outline Color (Цвет контура) появится, если выделить объект и щелкнуть мышью на [image: image170.bmp] во вспомогательной панели инструмента [image: image171.bmp].

· Сделать необходимые настройки и закрыть диалог.

Выбор модели кодирования цвета и самого цвета

Модель кодирования цвета можно выбрать с помощью открывающегося списка Model (Модель). По умолчанию диалог Uniform Fill (Однородная заливка) появляется на экране с палитрой CMYK модели. В правой части диалога находится окно, залитое оттенками цветов, и цветная вертикальная полоса. Перетаскивая мышью прямоугольник на цветной полосе, вы можете выбрать цвет, а перетаскивая прямоугольник в большом цветовом окне – яркость и насыщенность выбранного цвета.

Цвета и палитры

В поле Reference Color (Исходный цвет) отображается цвет заливки или контура объекта, который был выделен перед вызовом диалога, а в поле New Color (Новый цвет) – цвет выбранный в диалоге.

Под полем выбора модели находятся поля ввода со счетчиками для указания точных значений, составляющих цвета для выбранной модели. В нижней части диалога находится палитра цветов, из которой можно выбрать нужный цвет. Можно создать новую собственную палитру и сохранить ее на диске для последующего использования. Команды для работы с палитрами находятся во вспомогательном меню, которое вызывается с помощью в правой нижней части диалога.

Все цвета в палитре имеют свое название, поэтому для выбора цвета можно ввести название в поле ввода Name (Имя). Другой способ заключается в поиске цвета по названию с помощью поля ввода Search (Поиск).

Другой способ выбора составного цвета заключается в использовании цветового перетекания цветов.
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Причем по углам прямоугольника находятся кнопки для выбора четырех базовых цветов.

Еще один удобный способ выбора цвета заключается в использовании области смешивания цветов. 
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Работа с плашечными цветами и стандартными палитрами

Чтобы выбрать цвет из стандартной палитры, надо нажать кнопку , которая находится в правой части диалога .

Так как выбор цвета из стандартной палитры часто связан с поиском этого же цвета из печатного каталога, то наряду с изображениями цветов удобно просматривать их названия. Для этого необходимо выбрать команду меню Show Color Name (Показывать имена цветов) из вспомогательного меню, которое открывается с помощью кнопки [image: image174.bmp] в верхнем правом углу диалога. Эта команда появляется в меню только когда выбран режим просмотра стандартных палитр.

Работа с настраиваемыми палитрами

Когда вы создаете собственные цвета, вы можете присваивать им имена и добавлять их в готовые палитры. После окончания работы вы можете сохранить палитру под новым именем и автоматически загружать ее перед началом работы.

Нажав левой клавишей мыши на кнопке [image: image175.bmp], расположенной в верхней части полосы палитры, вы вызовите меню следующего вида:
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Выбрав пункт меню Палитра, вы сможете выполнить указанные в нем действия.
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Выбрав Правка → Редактор палитры, вы вызовите окно следующего вида:

[image: image178.png]Dpssiims user

DoGaeims user
Crepers user

opruposars useta

L

R ——

Voo [Black. -

User CO MO YO K100

Omeena | Dowous





Палитру цветов на экране можно перетаскивать с помощью мыши, размещая ее с любой стороны окна или оставляя в рабочей области окна.

Чтобы использовать расширенную палитру на экране, щелкните мышью на кнопке [image: image179.bmp] на полосе палитры. Появится палитра из нескольких рядов. Используйте стрелки полосы прокрутки, если необходимо просмотреть больше цветов. Щелчок мыши вне палитры закрывает расширенную палитру.
Задания

1 Создайте свою палитру.

2 Сохраните свою палитру.

3 Нарисуйте по выбору:

· морской пейзаж;

· заставку для компьютерной игры;

· гоночный автомобиль.

С помощью своей палитры разукрасьте рисунок.



Тема 9: Создание цветных изображений
Заливка объектов

Под заливкой мы понимаем цвет или узор  внутри замкнутого объекта. Для каждого типа заливки существуют настройки, которые позволяют модифицировать заранее определенные заливки, присутствующие в программе. В узорах, например, могут быть изменены размеры и используемые цвета. Вы можете даже создавать ваши собственные узоры с помощью любых графических изображений.

Вы можете заполнять объекты одной из следующих заливок:

· однородные цвета или оттенки серого (плашечные или составные цвета);

· градиентные заливки (линейные, радиальные, конические и квадратные);

· двухцветные и многоцветные узоры, имеющиеся в CorelDRAW или созданные вами;

· узоры в растровом формате;

· текстуры в формате PostScript;

· текстуры, создаваемые с помощью специальных алгоритмов.

Независимо от используемого вами метода прежде всего с помощью инструмента [image: image180.bmp] необходимо выделить объект, который вы хотите заполнить, а затем выбрать заливку.

Вспомогательная панель [image: image181.png]


 инструмента [image: image182.bmp] предлагает вам быстрый доступ к белому и черному цветам, четырем оттенкам серого, кнопку [image: image183.bmp] для удаления заливок и кнопку [image: image184.bmp], при нажатии на которую на экране появляется окно следующего вида:
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Однородная заливка

Палитра, расположенная справа в окне редактора, предлагает вам быстрый доступ к заранее определенным цветам для заполнения выделенных объектов. Чтобы выбрать цвет, просто щелкните на нем мышью. Для смешивания ваших собственных цветов или выбора заранее определенных цветов по их названию, используйте диалог Uniform Fill (Однородная заливка). Чтобы открыть его, выделите объект и откройте вспомогательную панель инструмента [image: image186.bmp], а в ней нажмите кнопку [image: image187.bmp].

Градиентная заливка

В градиентных заливках смешиваются два и более цветов или их оттенков, при этом создается плавный переход от одного цвета к другому.

Чтобы создать градиентную заливку, выполните следующие действия:

1 С помощью инструмента [image: image188.bmp] выделите объект, который вы хотите заполнить.

2 Щелкните мышью на инструменте [image: image189.bmp] на рабочей панели инструментов, а затем в открывшемся вспомогательном меню на кнопке [image: image190.bmp]. На экране появится диалог Fountain Fill (Градиентная заливка).
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3 Выберите опции по вашему желанию, а затем щелкните мышью на кнопке ОК.

Диалог Fountain Fill (Градиентная заливка) содержит следующие элементы управления для создания градиентных заливок.

Смесь цвета. Данная группа  элементов управления предназначена для определения цветов градиентной заливки. По умолчанию выбрана опция Два цвета, и вы можете определить начальный и конечный цвета. Для выбора начального цвета щелкните мышью на цветной кнопке, расположенной рядом со словом Из. Появится цветовая палитра. Выберите из нее начальный цвет. Конечный цвет выбирается тем же способом, только вы щелкаете мышью на кнопке рядом со словом К.

Когда выбрана опция Два цвета и нажата кнопка [image: image192.bmp], CorelDraw выбирает промежуточные цвета градиентной заливки вдоль прямой линии от начального цвета к конечному на цветовом колесе, расположенном слева в диалоге Fountain Fill (Градиентная заливка).

Когда нажата кнопка 
[image: image193.png]


 или [image: image194.bmp], CorelDraw выбирает промежуточные цвета градиентной заливки по пути вокруг цветового колеса. Вы можете определить направления пути. Щелкните мышью на кнопке [image: image195.bmp] для определения направления по часовой стрелке или на кнопке 
[image: image196.png]


 для определения направления против часовой стрелки. Цвета начала и конца заливки совпадают с конечными точками дуги. Этот метод дает более широкий спектр цветов градиентной заливки.

С помощью ползункового регулятора Центр устанавливается скорость изменения цвета градиентной заливки. Лучшей иллюстрацией работы этого регулятора является поле предварительного просмотра в правом верхнем углу диалога.

Тип. Вы можете создавать следующие основные типы градиентной заливки: линейный, конический, радиальный и квадратный. Линейная градиентная заливка изменяет цвет в одном направлении, определенном в поле ввода Угол, в то время как радиальная градиентная заливка изменяет цвет концентрическими кругами от центра к краям объекта. Коническая градиентная заливка изменяет цвет в конических формах от начального к конечному цвету в направлении против и по часовой стрелке. Квадратная градиентная заливка изменяет цвет в концентрических квадратах от центра к краям объекта. Когда вы выбираете тип градиентной заливки, в поле предварительного просмотра вы можете увидеть ее образец.

Планшет. Параметр Планшет позволяет увеличить размер начальной и конечной полос цветов в градиентной заливке. Максимальное значение, которое вы можете ввести, равно 49о.

Шаги. Щелчок мыши на кнопке [image: image197.bmp] рядом с полем ввода Шаги позволяет ввести число шагов, на которое вы хотите разделить установленный диапазон цветов градиентной заливки при печати и при просмотре на экране.

Угол. Для линейной и конической градиентных заливок вы определяете направление градиента в градусах. Угол описывает направление градации от первого определенного цвета ко второму. В случае квадратных заливок угол используется для вращения концентрических квадратов. Введите угол в поле ввода Угол или используйте стрелки прокрутки для определения значения. Градиентная заливка в поле предварительного просмотра изменится, как только вы установите угол.

Сдвиг центра. Вы можете смещать центр радиальных, конических и квадратных градиентных заливок произвольным образом. Чтобы сделать это, введите процентные значения в поля ввода Горизонтально и Вертикально. Отрицательные значения перемещают центр влево и вниз, положительные – вправо и вверх.

Выбор промежуточных цветов для градиентной заливки

Выбор опции Выборочный в группе Смесь цвета позволяет вам самостоятельно определить промежуточные цвета в градиентной заливке. Вы можете определить до 99 промежуточных цветов, поле предварительного просмотра обновляется всякий раз для отражения ваших настроек.

Чтобы определить промежуточные цвета градиентной заливки, выполните следующие действия.

1 С помощью инструмента [image: image198.bmp] выделите объект.

2 Откройте диалог Fountain Fill (Градиентная заливка) и щелкните мышью на опции Выборочный.

3 Поместите указатель мыши между двумя конечными маркерами – маленькими квадратиками, расположенными над цветной полосой предварительного просмотра в группе Смесь цвета и дважды щелкните левой кнопкой мыши. Наверху полосы предварительного просмотра появится треугольник (промежуточный цветовой маркер), который имеет черный цвет, если он выделен, и белый – при отмене выделения. Конечные и промежуточные цвета могут быть  отредактированы щелчком мыши на маркере с последующим выбором цвета из цветовой палитры. Поле Данный показывает цвет выбранного маркера. Вы можете выбирать сразу несколько маркеров, если при работе с мышью  вы нажмете клавишу Shift и будете удерживать ее нажатой. В этом случае поле Данный показывает цвет маркера, выбранного первым. На цветовой палитре, расположенной справа от полосы, также появляется селектирующая рамка для идентификации выбранного цвета.

4 Переместите маркер в то место, где вы хотите разместить промежуточный цвет. Как только вы переместите маркер, в поле ввода Позиция изменится процентное значение для отражения позиции маркера. Вы можете также ввести число в это поле ввода. В этом случае выбранный маркер передвинется в нужную позицию.

5 Щелкните мышью на цвете в цветовой палитре рядом с полосой. Цвет добавляется в градиентную заливку в поле предварительного просмотра на место выбранного маркера, меняя вид полосы цветов заливки.

6 Повторяйте эти шаги до тех пор, пока вы не выберите столько промежуточных цветов, сколько хотите. Каждый раз, когда вы добавляете промежуточный цвет, градиентная заливка в полосе предварительного просмотра обновляется.

7 После того как вы добавили цвет, вы можете перетащить его в другую позицию в градиентной заливке с помощью мыши. Чтобы удалить цвет, дважды щелкните мышью на его цветовом маркере.

Создание заготовки из градиентной заливки

Вы можете сохранить градиентную заливку как заготовку в диалоге Fountain Fill (Градиентная заливка).

Чтобы сохранить заливку, щелкните мышью в поле Установки. Появится текстовый курсор.

Введите название заливки и щелкните мышью на кнопке [image: image199.bmp]. Название заливки добавляется в список заливок в списке Установки.

Чтобы загрузить какую-либо из существующих градиентных заливок, откройте список Установки и выберите нужную вам заливку из списка. Заливка загружается в диалог Fountain Fill (Градиентная заливка).

Чтобы удалить заливку из списка Установки, сначала выберите заливку в списке, а затем нажмите кнопку [image: image200.bmp].

Заливка узором

CorelDRAW позволяет заливать замкнутые объекты узорами. При этом узоры заполняют внутреннюю область объекта как черепица – крышу. В CorelDRAW различают двухцветные узоры, многоцветные узоры и произвольные растровые изображения. Разница между двумя последними типами заполнителей весьма условна, при этом работа со всеми типами узоров практически одинакова.

Вы можете создать ваш собственный узор с помощью графических редакторов. Для простых двухцветных узоров удобно использовать редактор узоров, встроенный в CorelDRAW. Вы можете также создать узор с помощью инструментов рисования в CorelDRAW и затем сохранить его как двухцветный или многоцветный. Это делается с помощью команды меню Tools → Create → Pattern (Сервис → Создать  → Узор).

Чтобы залить узором, выполните следующие действия:

· С помощью инструмента [image: image201.bmp] выделите объект.

· Откройте вспомогательную панель инструмента [image: image202.bmp].

· В вспомогательной панели щелкните мышью на кнопке [image: image203.bmp]. Появится диалог Заливка узором. 
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Поле предварительного просмотра, расположенное в диалоге, предназначено для отображения образцов узоров.

· Выберите желаемый тип узора с помощью опций 2-цветный, Полноцветный, Битовое изображение. Единственное отличие двухцветного узора – это наличие в диалоге двух цветных кнопок для задания двух цветов и кнопки Создать, которая вызывает редактор двухцветного узора.

· Для просмотра палитры узоров щелкните мышью в любом месте поля предварительного просмотра.

· Прокручивая палитру с помощью полосы прокрутки, щелкните мышью на выбранном узоре.

· Выберите параметры «черепицы» узора с помощью элементов управления в группе Размер: Ширина, Высота.

С помощью элементов управления в группе Сдвиг ряда или колонки можно точно управлять расположением ячеек относительно объекта. Установите флажок Трансформировать заливку с объектом для того, чтобы, когда вы увеличиваете объект, узор тоже увеличивался.

В правом верхнем углу диалога находятся еще несколько кнопок.

· Щелкните мышью на кнопке Загрузить. Появится диалог для импорта файла с изображением узора. Для выбора файла щелкните мышью сначала на его имени, а затем на кнопке Открыть.

· С помощью кнопки Удалить вы можете удалить из палитры выбранный узор.

· Кнопка Создать, которая доступна только для двухцветных узоров, открывает диалог Редактор двухцветной палитры для создания или редактирования выбранного узора. Для рисования узора установите его размеры с помощью опций Размер битового изображения и размер пера для рисования – Размер пера. Затем щелкайте мышью в поле для рисования, при этом щелчок левой кнопки закрашивает квадраты, а правой – очищает.

Заливка текстурой

Для заливки объектов CorolDRAW предлагает так называемые процедурные текстуры. Это не что иное, как изображения, созданные с помощью специальных алгоритмов и генераторов случайных чисел. Процедурные текстуры напоминают некоторые природные явления, такие, как облака, минералы или вообще имеют фантастический вид.

Чтобы залить объект текстурой, выполните следующие действия.

1 Выделите объект с помощью инструмента [image: image205.bmp].

2 Откройте вспомогательную панель инструмента [image: image206.bmp].

3 В вспомогательной панели щелкните мышью на кнопке [image: image207.bmp]. Появится диалог Заливка текстурой.
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4 Из списка Текстурная библиотека выберите любую библиотеку. Название текстур из выбранной библиотеки отображаются в списке Список текстур.

5 Щелкните мышью на названии нужной текстуры в Списке текстур, и выбранная текстура отобразится в поле предварительного просмотра в соответствии с параметрами и цветами, заданными по умолчанию.

6 Измените, если пожелаете, любой из параметров текстуры. Щелкните мышью на кнопке Preview (Предварительный просмотр), чтобы увидеть результаты изменения параметров.

7 Щелкните мышью на кнопке ОК для применения заливки к выделенному объекту.

Кроме цветов текстуры существует множество параметров, которые можно изменять, таких как плотность, мягкость, контрастность, яркость, цвет тени, цвет бликов, размер волн, размер капель и т.д. При этом каждая текстура обладает собственным набором параметров. 

Заливка текстурой в формате PostScript
Заливку в формате PostScript нельзя увидеть на экране, ее можно распечатать только на принтере, который поддерживает указанный формат. Поэтому применять данный вид заливки следует осторожно.

Чтобы залить объект текстурой, выполните следующие действия.

1 Выделите объект с помощью инструмента [image: image209.bmp].

2 Откройте вспомогательную панель инструмента [image: image210.bmp].

3 В вспомогательной панели щелкните мышью на кнопке [image: image211.bmp]. Появится диалог Текстура PostScript.
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4 Установите флажок Просмотреть, чтобы просматривать вид текстуры в диалоге.

5 Выберите из списка подходящую структуру и закройте диалог с помощью кнопки ОК. Выделенный объект будет залит символами PS.

ЗАДАНИЕ

Создайте на выбор:

· пригласительный билет на КВН;

· пригласительный билет на дискотеку;

· поздравительную открытку;

· свою визитную карточку.



Тема 10: Обмен изображениями с другими программами и использование заготовок

Копирование и вставка объектов с помощью буфера обмена Windows
Как и другие программы, работающие в операционной среде Windows, CorelDRAW может работать с буфером обмена Windows. При этом можно помещать объекты в буфер для использования изображений другими приложениями или извлекать объекты из буфера и вставлять их в редактируемое изображение. Существует возможность вставлять не только векторную графику, но и растровые изображения, а также текстовые фрагменты.

Чтобы скопировать один или несколько объектов в буфер обмена, следует выделить их и нажать кнопку [image: image213.bmp] на панели инструментов Стандарт. Ваше изображение не изменится, однако выделенные объекты будут помещены в буфер обмена, откуда вы сможете их вставить в другое изображение CorelDRAW или в документ, создаваемый другим приложением Windows, например, текстовым редактором Microsoft Word. Если, выделив объект, вы нажмете кнопку [image: image214.bmp], то кроме помещения объектов в буфер обмена они будут удалены из редактируемого изображения.

Если вы попытаетесь закрыть редактируемое изображение или выйти из редактора CorelDRAW после того, как поместили объекты в буфер обмена, на экране появится диалог с предупреждением следующего вида:
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Если в буфере есть какая-либо информация, то доступна кнопка [image: image216.bmp] на панели инструментов Стандарт. Нажав ее, вы вставляете объект из буфера обмена в редактируемое изображение. При этом объект останется в буфере обмена, и вы можете вставлять его в изображение еще неограниченное число раз.

Импорт и экспорт изображений

Импорт файлов различных форматов.

· Чтобы вставить в создаваемое изображение рисунок из файла, созданного любым графическим изображением, следует нажать кнопку [image: image217.bmp] на панели инструментов Стандарт. На экране появится диалог Импорт, очень похожий на диалог открытия файла.

[image: image218.png]Wmnopr [2]x]

Donca [ S Monsowrarrs @1 A £
O _wicxers I Mon prcgon @i Orvens

|23 CoelUser s CiNporpara &
S0k (CICavcrern &
g Oiga %w Anexcaraposiy g 2

Visual1 3
[C1wen o I

KT 1]

Moo aiina: |1 I v Dpsanpocrarp
LTS S pp——— ] [wenwon =]

Brgina | Mo wromario I |

Pasmep. 87X 60 Touex, 16,7 Munnuoros usetos (24 paspana)

[ Consars pactp erewne
Poprar  BMP - Windows Bimap Uncompressed et
Mpesaryis = |z e (66 romne
[ Mposepute Ha goa. aar.

| He noxas. guanor dwneTpa

| Coparine ey i
I ez C e o Beie) pAa A Ereas e O





· Выберите в открывающемся списке Файлы типа значение Все форматы файлов. Теперь вы сможете увидеть в списке файлы всех типов.

· Установите флажок Предпросмотр, чтобы просматривать в специальном поле выбираемые рисунки, не загружая их.

· Перейдите в папку, где расположен файл с рисунком, который вы хотите импортировать.

· Щелкните мышью на названии необходимого файла. Просмотрите рисунок в поле предварительного просмотра.

· Нажмите кнопку Импорт. Диалог будет закрыт, а выбранный рисунок будет вставлен в редактируемое изображение CorelDRAW.

Иногда может возникнуть необходимость сохранения изображения, созданного с помощью графического редактора CorelDRAW, в файле другого графического формата. Такая операция называется экспортом изображения и выполняется с помощью кнопки [image: image219.bmp] на панели инструментов Стандарт. После нажатия этой кнопки на экране появится диалог Экспорт, похожий на диалог сохранения файла. В нем вы должны ввести имя файла и выбрать место, где хотите его сохранить.
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Важной операцией при работе с диалогом Экспорт является выбор формата файла, в котором будет сохранен рисунок. Вы должны выбрать в открывающемся списке Файлы типа один из графических форматов, который поддерживается CorelDRAW. Для некоторых форматов, поддерживающих сжатие информации, можно установить вид сжатия в поле Тип сжатия.

Если вы установите флажок Только выбранное, то в файл будут экспортированы не все объекты изображения, а только те, которые были выделены перед нажатием кнопки [image: image221.bmp]. При установленном флажке Не показывать диалог фильтра изображение будет экспортировано с параметрами, которые применялись при последнем экспорте. Диалог изменения параметров не появится. Чтобы иметь возможность изменения параметров преобразования вашего изображения в выбранный графический формат, следует убрать этот флажок.

Нажмите кнопку Экспорт, и на экране появится диалог настройки экспорта.
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В группе полей Цвет вы устанавливаете количество цветов, которое будет получено. Понятно, что при большом количестве цветов качество рисунка увеличивается, но также растет и размер файла. Если вы выберите рисунок с малым количеством цветов, до256, то станет доступным поле Размыть. Если установить флажок в этом поле, цвет, который отсутствует в палитре, будет имитироваться смешиванием нескольких существующих цветов. То есть вместо точек одного цвета в итоговом рисунке на том же месте могут быть несколько разноцветных точек, которые создают приблизительную иллюзию нового цвета.

В группе полей Размер вы устанавливаете размер итогового рисунка в точках. Если вы выберете размер Пользовательский, то с помощью полей Ширина и Высота вы можете задать конкретные размеры. Если вы нажмете на кнопку [image: image223.bmp], то пропорции исходного изображения будут сохранены.

В группе полей Разрешение задается разрешение рисунка в точках на дюйм. Если вы выберите в качестве разрешения Пользовательский, то с помощью полей Горизонтально и Вертикально вы можете задать нестандартное разрешение. Если вы нажмете на кнопку [image: image224.bmp], то вертикальное и горизонтальное разрешения будут идентичными.

Если вы установите флажок в поле Сглаживание, то изображение будет более «гладким» за счет удаления эффекта ступеньки на границах цветовых переходов.

Ожидаемый размер файла при установленных параметрах без учета сжатия будет показан в нижней части диалога. Если выбранный формат поддерживает сжатие, то реальный размер полученного файла будет значительно меньше.

Нажмите кнопку ОК, и будет создан графический файл в соответствии с выбранными вами параметрами.

Работа с растровыми изображениями

Растровые изображения состоят из отдельных точек-пикселей. Некоторые программы рисования, такие как Corel PHOTO-PAINT, работают только с этим типом графики. Несмотря на то, что CorelDRAW – это редактор векторной графики, он обладает функциями для импорта, создания и редактирования растровых изображений.

В отличие от векторной графики растровые изображения имеют фиксированную разрешающую способность. Это не является проблемой до тех пор, пока растровое изображение отображается или печатается при разрешающей способности, с которой оно было создано. Однако увеличение растрового изображения увеличивает пиксели, делая графику «зубчатой».

Уменьшение растрового изображения также вызывает искажение, так как для уменьшения растровой графики до нового размера лишние пиксели удаляются.

Программа автотрассировки Corel OCR-TRACE из пакета CorelDRAW позволяет вам преобразовывать растровые изображения в векторную графику. Для трассировки простых растровых изображений в редакторе CorelDRAW вы можете использовать инструмент [image: image225.bmp] или [image: image226.bmp].

CorelDRAW позволяет преобразовывать и экспортировать векторную графику в растровые изображения. Это позволяет использовать рисунки в прикладных программах, которые не позволяют использовать векторную графику.

Выбор видимой части растра

Усечение позволяет оставить видимой только часть растрового изображения. Чтобы усечь растровое изображение, используйте элемент [image: image227.bmp]. Если вам необходимо отобразить только маленькую часть большого растрового изображения, лучше всего используйте программу Corel PHOTO-PAINT для создания меньшего файла, который содержит только требуемую часть. Растровые изображения меньшего размера могут загружаться, отображаться и редактироваться более быстро и освобождают место на диске.

Усечение растрового изображения после импорта

Чтобы усечь растровое изображение, выполните следующие действия:

· С помощью команды меню Файл → Импорт вставьте растровое изображение.

· Выделите растровое изображение с помощью инструмента [image: image228.bmp]. В четырех углах обрамляющей рамки растрового изображения появятся черные узлы для управления отсечением.

· Переместите указатель мыши на один из узлов. Нажмите и удерживайте левую кнопку мыши. Переместите указатель мыши к центру растрового изображения для усечения его вдоль этого края.

· Переместите указатель мыши от растрового изображения для открытия  любой части растрового изображения, которое было спрятано во время предыдущей операции усечения.

· Отпустите левую кнопку мыши. Изображение перерисуется с заданным усечением.

Существует способ импортировать не все растровое изображение, а только его часть.

Усечение растрового изображения перед импортом

· Выберите команду меню Файл → Импорт. На экране появится диалог Импорт.

· Откройте список, расположенный сразу после списка Файлы типа и выберите строку Обрезка.

· Выберите нужный файл и нажмите кнопку Импорт. На экране появится диалог для выбора части растрового изображения.
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· Перетаскивая мышью черные квадраты в поле просмотра растрового изображения, установите нужный размер рамки. Затем перетащите саму рамку на нужное место, для этого установите указатель мыши внутри ее, нажмите и удерживайте левую кнопку мыши, переместите мышь.

· После того, как вы выделили с помощью рамки нужный фрагмент растрового изображения, закройте диалог с помощью кнопки ОК.

Следует отметить, что нужную часть растрового изображения можно выбрать с помощью полей ввода в нижней части диалога Обрезать изображение, предварительно установив единицы измерения в открывающемся списке Единицы. Нажав кнопку Выбрать все, можно привести рамку к исходному состоянию, когда она обрамляет все изображение в окне просмотра.

Трассировка растра

Трассировка растрового изображения преобразовывает его в векторный объект, который может редактироваться и масштабироваться без искажения.

Трассировка растрового изображения

Чтобы автоматически трассировать растровое изображение, выполните следующие действия.

· Загрузите растровое изображение в CorelDRAW с помощью команды меню Файл → Импорт.

· Используйте инструмент [image: image230.bmp] для увеличения масштаба площади, которую вы хотите трассировать.

· Выделите растровое изображение.

· С выделенной растровой графикой щелкните мышью на инструменте [image: image231.bmp] или [image: image232.bmp]. Когда вы выбираете один из указанных инструментов с выделенным растровым объектом, вы автоматически включаете режим автотрассировки. 

· Поместите курсор к самому краю площади в растровом изображении, которое вы хотите трассировать, и щелкните мышью. CorelDRAW автоматически находит площадь одинакового цвета рядом с курсором и трассирует ее в векторный объект.

· Продолжайте трассировать столько областей рисунка, сколько необходимо. Если вы щелкнули мышью, чтобы начать трассировку, и кажется, что ничего не происходит, то, скорее всего, в этом месте находится маленькая группа пикселей одного цвета, которая не видна при данном увеличении. Переместите немного в сторону указатель мыши и попытайтесь снова. Если вы опять столкнулись с той же самой проблемой, сделайте больше масштаб изображения с помощью инструмента [image: image233.bmp].

Когда вы закончите автотрассировку, то сможете удалить растровое изображение.

Раскрашивание черно-белого растра

Вы можете применить цвет к переднему плану или фону черно-белого растрового изображения, но не можете сделать полутоновые или цветные растровые изображения.

Раскрашивание черно-белого растрового изображения

· Чтобы раскрасить монохромное растровое изображение, выделите его с помощью инструмента [image: image234.bmp].

· Щелкните мышью на кнопке [image: image235.bmp] во вспомогательной панели инструмента [image: image236.bmp]. Выберите цвет переднего плана с помощью диалога Цвет контура. Черные пиксели в черно-белом растровом изображении представляют передний план. Закройте диалог с помощью кнопки ОК для применения выбранного цвета к растровому изображению.

· Затем щелкните по кнопке [image: image237.bmp] во вспомогательной панели инструмента [image: image238.bmp]. Выберите цвет фона с помощью диалога Однородная заливка. Белые пиксели в черно-белом растровом изображении представляют фон. Щелкните мышью на кнопке ОК для применения выбранного цвета к растровому изображению.

Следует отметить, что более быстрый способ раскрашивания заключается в том, чтобы щелкнуть правой, а затем левой кнопкой в нужных ячейках палитры в окне CorelDRAW.
Преобразование векторного объекта в растровое изображение с использованием фильтров

CorelDRAW обладает возможность преобразовать векторное изображение в растровое. Зачем? Чтобы применить к растровому изображению специальный эффект или фильтр, например, для создания иллюзии рисования акварелью. CorelDRAW содержит довольно большой список встроенных фильтров для обработки растровых изображений.

Преобразование векторной графики в растровую

· Выделите векторные объекты, которые вы хотите преобразовать в растровый формат.

· Выберите команду меню Битовые изображения → Конвертировать в битовое изображение. На экране появится диалог Конвертировать в растр, в котором необходимо выбрать параметры будущего растрового изображения. 
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· Установив нужные параметры, закройте диалог с помощью кнопки ОК.

С помощью списка в группе Цвет устанавливается количество цветов в растровом изображении. Флажок Сглаживание управляет гладкость переходов на границах цветов, т.е. позволяет устранить эффект «ступеньки». Флажок Размытый следует использовать в том случае, если какой-либо цвет не может быть отображен при заданном количестве цветов. При установке флажка Размытый такой цвет будет имитироваться смешиванием точек доступных цветов. С помощью флажка Прозрачный фон можно установить прозрачной область, не занятую векторными объектами в будущем растре.

Список Разрешение позволяет выбрать разрешение растра в точках на дюйм. 

После того, как вы получили растровое изображение, можно изменить его формат. Также можно изменить размер и разрешение растра.

Применение фильтров к растровому изображению

Рассмотрим применение фильтров к растровым объектам на примере эффекта, воспроизводящего манеру рисования импрессионистов.

· Выделите растровый объект.

· Выберите команду меню Битовые изображения → Художественный штрих → Импрессионист. На экране появится диалог для настройки параметров эффекта. Следует отметить, что если команда меню Художественный штрих недоступна, то следует предварительно преобразовать растр в формат RGB с помощью команды Битовые изображения → Вид → RGB (24-разрядное).

· Переместите регуляторы в диалоге настойки. Затем нажмите кнопку [image: image240.bmp], чтобы посмотреть как будет выглядеть эффект прямо в документе. Причем, если после просмотра вы нажмете кнопку Сброс, то эффект не будет применяться к растру.

· Закройте диалог с помощью кнопки ОК. Эффект будет применен к растру.

Еще одной возможностью CorelDRAW для работы с растровыми изображениями является создание цветовой маски. Цветовая маска позволяет скрыть указанные цвета или наоборот оставить только выбранные цвета в растровом изображении.

Создание цветовой маски

· Выделите растровое изображение и выберите команду меню Битовые изображения → Битовое изображение Цвет маска. На экране появится свиток Растрово-цветная рамка.

· Откройте список в верхней части свитка и выберите строку Скрыть цвета.

· Щелкните мышью на самой верхней цветовой полосе в свитке, чтобы сделать ее текущей.

· Нажмите кнопку [image: image241.bmp] в свитке и щелкните мышью на нужном цвете в растровом изображении. Цвет отобразится в верхней цветовой полосе.

· Установите флажок напротив цветовой полосы с выбранным цветом и нажмите кнопку Принять. Выбранный цвет исчезнет из растрового изображения.

· Если вы хотите скрыть также все цвета близкие к выбранному, измените положение регулятора Чувствительность и снова нажмите кнопку Принять.

Аналогичным образом вы можете задавать одновременно множество цветов с различными погрешностями. После чего, если это необходимо, существует возможность сохранить маску в файле на диске. Для этого нажмите кнопку [image: image242.bmp].

ЗАДАНИЕ

Создайте на выбор один из следующих фирменных знаков:

· художника;

· писателя;

· юриста;

· певца;

· музыканта;

· педагога;

· летчика.



Тема 11: Ввод и редактирование текста
Фигурный и простой текст

В графическом редакторе CorelDRAW существует возможность работы с двумя разновидностями текстовых объектов: с фигурным (Artistic) и простым (Paragraph) тестом. Фигурный текст представляет собой как бы рисунок из символов, с которым можно работать, как с любым другим объектом CorelDRAW. Простой же текст представляет собой обыкновенный текст в рамке, вставленный в рисунок. Вы можете менять границы рамки простого текста или придавать рамке замысловатую форму, но внутри текст будет располагаться точно также, как и в любом текстовом редакторе. Фигурный текст используется для ввода небольшого текста от одного символа до нескольких слов. Простой текст предназначен для ввода больших объемов текстовой информации и часто используется при создании рекламных буклетов и объявлений. По сравнению с фигурным простой текст представляет больше возможностей для форматирования.

Вы можете вводить текст одним из четырех способов:

· набирая с помощью клавиатуры непосредственно в рабочем окне;

· набирая с клавиатуры в диалоге редактирования текста;

· импортируя из файла, созданного другой прикладной программой, с помощью команды меню Файл → Импорт;

· передавая фрагмент текста из другой прикладной программы с помощью буфера обмена Windows.

Текст может редактироваться непосредственно на экране или в диалоге Редактировать текст. Вы можете изменить любой из текстовых атрибутов, таких как размер шрифта, начертание символов, выравнивание, и аналогичные, с помощью команд меню Текст → Форматировать текст и Текст → Редактировать текст. Кроме того вы можете поменять атрибуты текста с помощью Панели Свойств.

Символы фигурного текста, как и любой другой объект в CorelDRAW, имеют контуры и заливку. Вы можете применять к тексту специальные эффекты и преобразования, как и к любому другому объекту CorelDRAW. Текст остается редактируемым независимо от того, каким способом он был искажен, при условии, что он не был преобразован в кривые.

Форматирование, которое вы можете применить к тексту включает изменение гарнитуры и размера шрифта и интервалов. Каждый символ может иметь свой формат. Возможности форматирования простого текста позволяют вам выполнять следующие действия:

· Создавать перетекание текста в колонках и между рамками.

· Добавлять маркеры и использовать эффект буквицы.

· Устанавливать табуляторы и отступы.

· Автоматически переносить текст.

CorelDRAW может проверить орфографию и грамматику вашего текста по словарю, который вы можете пополнить своими собственными словами и синонимами.

Ввод текста

Ввод фигурного текста
Чтобы ввести фигурный текст, выполните следующие действия:
· Нажмите кнопку [image: image243.bmp] на Панели инструментов.

· Установите указатель мыши на то место, где вы собираетесь ввести текст.

· Щелкните левой кнопкой мыши. На месте щелчка появится вертикальная черта – текстовый курсор, который указывает, куда будет вставлен следующий символ при вводе с клавиатуры.

· Вводите текст, набирая его с клавиатуры. На месте, отмеченном текстовым курсором, появляется очередной символ, и курсор перемещается вправо.

Существует возможность располагать фигурный текст в несколько строк. Для перехода на следующую строку надо нажимать клавишу Enter. При этом в текст вставляется символ конца абзаца.

Ввод простого текста
Чтобы ввести простой текст, вы должны сначала создать рамку, в которой он будет расположен. Как только текст будет помещен в рамку,  вы можете перемещать его с помощью инструмента [image: image244.bmp].

· Нажмите кнопку [image: image245.bmp] на Панели инструментов.

· Подведите указатель мыши к верхнему левому краю области, в которой вы хотите разместить текст.

· Нажмите левую кнопку мыши и, не отпуская ее, начните передвигать мышь. На экране появится пунктирная рамка, размеры которой меняются вместе с передвижениями мыши.

· Подберите нужный размер пунктирной рамки и отпустите кнопку мыши. Рамка на экране станет сплошной, а в ее начале появится текстовый курсор.

· Введите несколько предложений. При достижении края рамки текст автоматически переносится на новую строку. Для перехода к следующему абзацу следует нажать клавишу Enter.

Как только текст появился на странице, вы можете редактировать и форматировать его. Если вы нажмете кнопку [image: image246.bmp], то будет выделен целиком текстовый объект, и вокруг рамки появятся прямоугольники обрамления. Если вы с помощью мыши переместите один из обрамляющих прямоугольников, расположенных на рамке простого текста, то изменится размер рамки, но не текст внутри нее. Как и с другими объектами, если вы дважды щелкните мышью на тексте или рамке, то вместо квадратов управления появятся стрелки для вращения и перекрашивания объекта.

Если ваш текст целиком не помещается в рамку на экране, вы можете с помощью инструмента [image: image247.bmp] растянуть ее длину. Для этого необходимо выделить рамку и потянуть за один из квадратов, расположенных посередине верхней и нижней сторон рамки.

Простой текст сохраняет свой первоначальный размер независимо от того, меняете ли вы размеры ограничивающей рамки. Но если вы сделаете поля слишком узкими, то часть или весь текст исчезнет. Чтобы изменить размеры простого текста при масштабировании рамки, нажмите и удерживайте клавишу Alt в процессе изменения размеров рамки.

Простой текст в нескольких рамках

Вы можете связать рамки на одной и той же или различных страницах таким образом, чтобы текст автоматически перетекал из одной рамки в другую. Если вы уменьшите первую рамку или увеличите размер текста, текст автоматически перетечет во вторую рамку, если эти две рамки являются связанными. Точно так же, если вы увеличите первую рамку, текст перетечет в нее из второй рамки.

Перетекание простого текста между рамками

Чтобы текст перетекал между рамками на одной и той же странице, выполните следующие действия.

· Создайте рамку для простого текста и введите несколько предложений, чтобы текст не помещался целиком в рамке.

· Создайте вторую рамку на свободном месте.

· Выберите инструмент [image: image248.bmp] и щелкните на тексте, чтобы выделить первую рамку. Обратите внимание, что верхний прямоугольник на рамке пустой[image: image249.bmp], а нижний содержит стрелку [image: image250.bmp]. Это означает, что текст не поместился целиком в созданной рамке. Если текст помещается целиком, то нижний прямоугольник также будет пустым [image: image251.bmp].

· Щелкните мышью на прямоугольнике [image: image252.bmp] (или [image: image253.bmp]) внизу рамки.

· Щелкните мышью на месте, где вы создали вторую рамку. При этом автоматически создается связь с новой рамкой. Продолжение текста появится во второй рамке. 

Аналогично вы можете связать вторую рамку с третьей, третью с четвертой и так далее.

Если при связывании рамок вы щелкните мышью на пустом квадрате [image: image254.bmp] наверху первой рамки вместо нижнего квадрата, то после щелчка мыши на второй рамке текст будет перетекать из второй рамки в первую.

Чтобы связать рамки, расположенные на разных страницах, следует выполнить точно такие же действия, как и при связывании рамок, расположенных на одной странице. Щелкните мышью на ярлычке с номером страницы, где расположена вторая рамка, а после этого щелкните мышью на нужной рамке.

Если вы щелкните не на второй рамке, а на свободном месте, то для перетекания текста будет создана новая рамка большего размера, занимающая почти всю рабочую область. Чтобы в любой момент видеть все созданные рамки, следует включить режим просмотра каркаса с помощью команды меню Показать → Каркас.

Разрыв связи между рамками простого текста

· Чтобы удалить связь межу рамками. Выделите рамку, из которой вы хотите удалить связь, и щелкните мышью на прямоугольнике [image: image255.bmp] внизу рамки.

· Щелкните еще раз на том же квадрате. Связь между рамками будет разорвана.

Если же вы просто удалите рамку, в которую перетекал текст, фрагмент текста также будет удален.

Импорт и вставка текста

Вы можете использовать буфер обмена Windows для вставки текста из другой прикладной программы в графический редактор CorelDRAW.

Вставка текста из буфера обмена Windows
· Чтобы вставить простой текст в CorelDRAW из буфера обмена, сначала поместите текст в буфер обмена с помощью любого текстового редактора.

· Перейдите в CorelDRAW и с помощью инструмента [image: image256.bmp] создайте рамку для текста.

· Нажмите кнопку [image: image257.bmp] панели инструментов Стандарт. Текст будет вставлен в редактируемое изображение.

· Для вставки фигурного текста из буфера обмена в документ CorelDRAW выберите инструмент [image: image258.bmp], щелкните мышью в том месте, где бы вы хотели, чтобы появился текст, а затем нажмите кнопку [image: image259.bmp].

Если вы не находитесь в режиме ввода простого или фигурного текста, то есть на экране нет текстового курсора, то текст будет вставлен как объект, созданный другим приложением, и вы не сможете применять к нему эффекты CorelDRAW.

Импорт простого текста

В том случае, когда текст находится в одном из форматов текстового файла, поддерживаемых CorelDRAW, таких как Microsoft Word, WordPerfect, или другой, импортируйте его с помощью команды меню Файл → Импорт, которая сохраняет табуляторы, отступы и другую информацию о формате.

· Выберите команду меню Файл → Импорт. На экране появится диалог Импорт.
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· В открытом диалоге выберите формат файла в списке Файлы типа. Чтобы просматривать файлы всех типов, следует выбрать вариант Все форматы файлов.

· Перейдите в папку, в которой расположен необходимый файл.

· В поле ввода Имя файла введите имя файла, который вы хотите импортировать.

· Щелкните мышью на кнопке Импорт. Текст появится в рамке на вашей странице.

Для всех текстовых форматов, кроме ASCII, размер рамки соответствует размерам страницы и ее полям в прикладной программе, из которой вы его импортируете. Для ASCII текста размеры рамки соответствуют текущим размерам и полям CorelDRAW. Первая рамка размещается наверху любых объектов на странице. Любые последующие рамки размещаются на дополнительных страницах, которые создаются по мере необходимости.

Выделение текста

Вы можете выделить текстовый объект целиком или выделить часть текста, используя различные инструменты. После выделения фрагмента текста или всего текстового объекта, вы можете удалить его или изменить атрибуты символов.

С помощью инструмента [image: image261.bmp] выделяется целиком весь текстовый объект. При помощи этого инструмента вы также можете выделить несколько текстовых объектов, чтобы применить к ним одинаковое форматирование. Если вы выделили текстовый объект с помощью инструмента [image: image262.bmp], и изменяете форматирование, то изменения коснутся всего текста целиком.

Инструмент [image: image263.bmp] применяется для выделения и редактирования узлов. 

Приемы выделения фрагментов текста

С помощью инструмента [image: image264.bmp] вы можете выделить любой фрагмент как фигурного, так и простого текста. Рассмотрим несколько способов выделения фрагментов текста.

· Введите фигурный и простой текст, а затем выделите разные фрагменты текста. При этом выделение фрагментов текста разных типов совершенно одинаково.

· Так как после ввода текста кнопка [image: image265.bmp] осталась нажатой, то снова не надо ее нажимать. Переместите указатель мыши на место, где расположен выделенный ранее текст. 

· Подведите указатель к началу фрагмента, который вы хотите выделить.

· Нажмите левую кнопку мыши и, не отпуская ее, передвигайте мышь. Символы между началом выделения и указателем будут отмечены серым фоном.

· Подведите указатель мыши к концу фрагмента, который вы хотите выделить, и отпустите клавишу. Фрагмент остался выделенным.

· Щелкните мышью и выделение будет снято, а на месте щелчка появится текстовый курсор.

· Дважды щелкните на любом слове, и будет выделено это слово целиком.

· Установите указатель мыши перед первым символом фрагмента, который надо выделить, и щелкните мышью. На месте щелчка появится текстовый курсор.

· Нажмите клавишу Shift и удерживайте ее до конца операции.

· С помощью клавиш управления курсором переместите текстовый курсор к концу области, которую надо выделить. Можно также щелкнуть мышью в конце данной области.

· Отпустите клавишу Shift, и необходимый фрагмент будет выделен.

Редактирование текста

Вы можете редактировать текст непосредственно на экране или в диалоге. Использование диалога Редактирование текста может облегчить редактирование фигурного текста, который был уже повернут, перекошен или преобразован каким-либо другим образом; однако вы можете редактировать преобразованный текст и на экране. Текст, к которому вы применили один из специальных эффектов, должен редактироваться в диалоге.

Чтобы отредактировать и отформатировать текст, выберите инструмент, соответствующий типу изменений, которые вы хотите сделать.

· Выберите инструмент [image: image266.bmp], чтобы редактировать текст в диалоге, или форматировать выделенные текстовые объекты, или применять новое начертание к выделенным объекта.

· Выберите инструмент [image: image267.bmp], чтобы редактировать текст на экране, или форматировать выделенные символы, или применять новое начертание к выделенным текстовым символам.

· Выберите инструмент [image: image268.bmp], чтобы выполнить кернинг текста или форматировать выделенные символы.

· Выберите команду Редактировать текст из меню Текст, чтобы редактировать текст и изменить атрибуты символов. Вызвать диалог редактирования текста также можно с помощью кнопки [image: image269.bmp] на Панели свойств.

· Выберите команду Форматировать текст из меню Текст или нажмите кнопку [image: image270.bmp] на Панели свойств, чтобы изменить формат шрифта. Вы можете изменить гарнитуру, размер и начертание шрифта, размещение (нормальное, верхний или нижний индекс) или ввести подчеркивание, размещение линии над строкой, зачеркивание, горизонтальное и вертикальное смещение, а также другие параметры форматирования. При этом изменения коснуться лишь выделенного текста.

· Используйте инструменты Панели свойств, чтобы изменить основные атрибуты текста.

Вы можете преобразовать фигурный текст в простой и простой текст в фигурный. Для этого следует выделить текстовый объект с помощью инструмента [image: image271.bmp], а затем выбрать воспользоваться командой Преобразование в простой текст или Преобразование в фигурный текст из меню Текст. Следует помнить, что при преобразовании могут быть утеряны некоторые особенности форматирования, присущие только одному типу текста.

Для изменения регистра выделенных символов удобно использовать команду Текст → Изменить регистр. На экране появится диалог Изменить регистр, в котором вы должны выбрать вариант изменения регистра выделенных символов, после чего нажать кнопку ОК.
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Форматирование текста

После того, как вы ввели текст, вы можете отформатировать его с помощью различных средств, предоставляемых графическим редактором CorelDRAW. Форматирование фигурного и простого текста несколько отличаются друг от друга, хотя и имеют много общего. Рассмотрим форматирование различных типов текста в редакторе. Если в выбрали инструмент [image: image273.bmp] из Панели инструментов и, не вводя или выделяя текст, попытаетесь изменить форматирование, то этим вы поменяете значения форматирования, принятые по умолчанию.

Изменение атрибутов текста, используемых по умолчанию

· Чтобы изменить гарнитуру и размер шрифта, которые заданы по умолчанию, следует отменить выделение объектов, если оно есть.

· После этого, не выделяя ни одного объекта, выберите инструмент [image: image274.bmp] из Панели инструментов. На экране появится диалог Атрибуты текста.
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· Установите флажок Художественный тест или Абзацный текст в зависимости от того, для текста какого типа вы хотите изменить заданные по умолчанию атрибуты.

· Закройте диалог с помощью кнопки ОК.

Изменение атрибутов символов

Вкладка Характеристики диалога Форматировать текст, который открывается при выборе команды Текст → Форматировать текст или при нажатии кнопки [image: image276.bmp] Панели инструментов, позволяет изменять гарнитуру, начертание и размер шрифта выделенного текста. Поля этой вкладки идентичны для фигурного и простого текста.
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Установка интервалов

Вкладка Абзац диалога Форматировать текст, предназначена для установки расстояния между символами и словами в тексте. Вызвать диалог можно с помощью команды меню Текст → Форматировать текст или нажатием кнопки [image: image278.bmp] Панели инструментов.

Количество доступных элементов управления вкладки зависит от типа текста и способа выделения.

Точное задание межсимвольных интервалов

С помощью инструмента [image: image279.bmp] вы можете изменить расстояние между соседними символами. Эта операция называется кернингом. Кернинг можно применять как к простому, так и к фигурному тексту. Кернинг перемещает соседние символы ближе или дальше друг от друга. Вы можете делать кернинг текста интерактивно  с помощью мыши, вводить значения в диалоге или использовать клавиши управления курсором.

Кернинг символов

· Выберите инструмент [image: image280.bmp] и щелкните мышью на тексте. Вы заметите, что рядом с каждым символом появятся маленькие пустые квадратики или узлы.

· Чтобы выделить символы, которые вы хотите подвинуть, щелкните мышью на узле слева от нужного символа или выделите несколько узлов с помощью инструмента [image: image281.bmp].

· Установите указатель мыши на одном из выделенных узлов. Нажмите и удерживайте левую кнопку мыши, переместите указатель мыши на новую позицию. Вместе с указателем мыши будут сдвинуты и символы.

Чтобы выполнить кернинг текста с помощью клавиш управления курсором с использованием инструмента [image: image282.bmp], щелкните мышью на узле слева от символа, который вы хотите переместить, и нажмите нужную клавишу управления курсором, чтобы переместить символ в требуемом направлении. Если вы будете удерживать клавишу управления курсором нажатой, символ будет перемещаться непрерывно. 

Чтобы выполнить кернинг текста с помощью диалога, выполните следующие действия.

· С помощью инструмента [image: image283.bmp] щелкните мышью на узле слева от символа, который вы хотите переместить. Появится диалог Форматировать текст.

· Выберите закладку Абзац данного диалога.

· Установите нужные значения в соответствующих полях.

· Закройте диалог с помощью кнопки ОК.

Простой текст в несколько колонок

Вкладка Столбцы диалога Форматировать текст позволяет разделить простой текст на колонки. Используйте инструмент [image: image284.bmp] для выделения рамки или выберите инструмент [image: image285.bmp] и щелкните мышью внутри рамки. Затем выберите команду меню Текст → Форматировать текст. Перейдите на вкладку Столбцы.
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Текст в несколько колонок часто используется при создании рекламных листков, газет, журналов. Такой текст выглядит профессионально оформленным.

Табуляция и отступы

Вкладка Табуляция диалога Форматировать текст обеспечивает возможность для установки табуляторов и отступов в простом тексте. По умолчанию каждый абзац в текстовой рамке имеет предварительно установленные табуляторы, которые составляют половину дюйма, что соответствует приблизительно 12,7 мм. Вы можете изменить заданную по умолчанию установку и установить собственные значения табуляции. Поля данной вкладки также предназначены для такой функции, как отступы. Данная функция позволяет задать ширину формата набора , а также форму и размер отступа абзаца.
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Символы маркировки и буквица

С помощью возможностей вкладки Эффекты диалога Форматировать текст можно добавить в начало абзацев специальные символы бюллетеня или маркеры в виде различных символов, заранее подготовленных и распределенных по различным тематическим группам. Кроме того, с помощью этой вкладки вы можете применять к абзацам эффект буквицы, т.е. увеличивать первую букву абзаца.

Чтобы добавить символы маркировки, выполните следующие действия.

· Введите простой текст, в который вы хотите добавить символы маркировки. Отделите каждый блок текста, который будет начинаться с символа маркировки, нажатием клавиши Enter, т.е. разбейте текст на абзацы.

· С помощью инструмента [image: image288.bmp] отметьте абзацы, в которые вы хотите вставить символы маркировки. Для этого нажмите левую кнопку мыши и выделите текст.

· Выберите команду меню Текст → Форматировать текст. Откроется диалог Форматировать текст.

· Щелкните мышью на ярлычке вкладки Эффекты наверху диалога.

· Выберите строку Маркировка в поле Тип эффекта.

· Откройте поле со списком Символы и выберите нужный вам символ, щелкнув на нем мышью.

· В поле ввода Размер определите размер символа.

· Ведите значение в поле Сдвиг баз. линии, чтобы сдвинуть символ маркера вверх или вниз относительно первой строки основного текста.

· В группе элементов управления Отступы выберите один из вариантов: Маркированный или Висящий отступ.  

· Нажмите кнопку ОК. Символы в начале выделенных абзацев появятся с заданными по умолчанию атрибутами контура и заливки.

Создание буквицы

Чтобы применить эффект буквицы, выполните следующие действия.

· Введите простой текст и разбейте его на абзацы. С помощью инструмента [image: image289.bmp] отметьте абзацы, в которые вы хотите вставить буквицу.

· Выберите команду меню Текст → Форматировать текст. Откроется диалог Форматировать текст. Щелкните мышью на ярлычке вкладки Эффекты наверху диалога.

· Выберите строку Буквица в поле Тип эффекта.

· В поле ввода Опущенные определите размер первого символа, т.е. сколько строк занимает буквица.

· В группе элементов Отступы выберите один из вариантов: Опущенный или Висящий отступ. Введите значение в поле Расст. от текста, чтобы определить отступ первых строк текста относительно буквицы.

· Нажмите кнопку ОК. В начале выделенных абзацев первый символ будет увеличен.

Выравнивание текста по опорной линии и выпрямление текста

В CorelDRAW имеются средства для автоматического расположения символов текста в нужных местах. Для этой цели служат команды, расположенные в меню Текст: Выровнять по базовой линии и Выровнять текст. Первая команда только выравнивает текст по базовой линии, т.е. отменяет все вертикальные смещения символов, а вторая команда, кроме того, отменяет горизонтальные смещения и повороты отдельных символов. Базовой линией называется воображаемая линия, по которой выравниваются все символы в строке текста.

Если вы выделите с помощью инструмента [image: image290.bmp] фрагмент текста и выберите команду меню Текст → Выровнять по базовой линии, то выделенные символы будут возвращены к расположению по опорной линии. Если символы были повернуты или смещены в горизонтальном направлении, то они останутся измененными. Чтобы, кроме расположения по опорной линии, отменить поворот и горизонтальное смещение символов, следует воспользоваться командой меню Текст → Выровнять текст.

С помощью этих команд легко отменять преобразования с текстом, выполненные с помощью инструмента [image: image291.bmp]. После выполнения данных команд все установленные интервалы для текста остаются без изменений.

Цвет текста

Текст, как и любой другой объект в CorelDRAW, имеет цвет контура и заливки. По умолчанию, заливка текста черная, а контур текста бесцветен. Вы легко можете поменять цвета, пользуясь обычными приемами для работы с контуром и заливкой объектов.

Выбор цветов для заливки и контура текста

· Выделите текстовый объект с помощью инструмента [image: image292.bmp] или выделите фрагмент текста с помощью инструмента [image: image293.bmp].

· Щелкните левой кнопкой мыши на цвете в цветовой палитре. Цвет заливки текста будет изменен.

· Чтобы изменить цвет контура текста, щелкните правой кнопкой мыши на цвете в цветовой палитре.

Вы можете также использовать инструмент [image: image294.bmp] для выделения отдельных символов. Таким образом, выбор цвета заливки текста и цвета контуров текста ничем не отличаются от выбора цвета для других графических объектов.

Копирование свойств текста

Вы можете скопировать атрибуты одной текстовой строки в другую с помощью команды меню Редактировать → Копировать свойства из. Эта команда позволяет скопировать любые, а не только текстовые атрибуты. Следует только выбрать в диалоге необходимые для копирования атрибутов.

Копирование текстовых атрибутов

Чтобы скопировать текстовые атрибуты из одного текстового объекта на другой, выполните следующие действия.

· С помощью инструмента [image: image295.bmp] выделите текстовый объект или несколько объектов, стиль которых вы хотите изменить.

· Выберите команду меню Редактировать → Копировать свойства из. Появится диалог Копирование свойств.
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· Установите флажок Свойства текста. Эти атрибуты включают гарнитуру и начертание шрифта, размер шрифта, интервал и выравнивание, а также специальные эффекты.

· Нажмите кнопку ОК.

· Щелкните мышью на текстовой строке, из которой вы хотите скопировать атрибуты. Выделенные первоначально текстовые объекты изменят форматирование

Существует другой способ копирования атрибутов, о чем говорится в диалоге Копирование свойств.

· Выберите инструмент [image: image297.bmp].

· Подведите указатель мыши к текстовому объекту, свойства которого вы хотите скопировать на другой объект.

· Нажмите правую кнопку мыши и, не отпуская ее, начните передвигать мышь.

· Подведите указатель к объекту, на который вы хотите копировать свойства, и отпустите правую кнопку мыши. На экране появится контекстное меню.
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· Так как отдельно текстовые свойства нельзя скопировать, копируйте все свойства объекта, выбрав команду Копировать Все Свойства. Все свойства первого объекта, включая текстовые, будет скопированы на второй объект.

Размещение фигурного текста вдоль кривой

При размещении текста по контуру другого текстового объекта следует предварительно преобразовать объект, по которому вы хотите разместить текст, в кривые. Чтобы разместить текст вдоль кривой используйте команду меню Текст → Текст вдоль пути. Кроме того, вы можете интерактивно разместить текст вдоль кривой и поменять параметры размещения с помощью Панели свойств. Разместить вдоль кривой можно только текст, состоящий из нескольких строк, все переводы строк будут удалены.

Текст и объект, по которому вы его размещаете, динамически связаны. Это означает, что если вы редактируете форму кривой, то текст, размещенный по ней, автоматически заново размещается по новой форме кривой. Точно так же, если вы редактируете текст, он будет заново размещен по существующей кривой. Вы можете разместить две или более строки текста вдоль одной и той же кривой. Все текстовые строки, размещенные вдоль одной кривой, будут динамически связаны с ней. Если вы хотите прервать эту динамическую связь, выделите группу, включающую текст и кривую, а затем выберите команду меню 
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